Wordpress Themes

Wordpress Themes

Goals

By the end of this case you will:

- Understand the structure and organization of a WordPress theme and be
able to modify the code to add custom functionality, such as creating
custom post types and taxonomies.

- Learn how to create a child theme and make advanced customizations to
a parent theme without affecting the original code.

- Develop the ability to create custom page templates, and understand the
use of template parts and the loop to create dynamic pages.

>

### Introduction

In this section, we will delve deeper into the intricacies of WordPress
theme development. Specifically, we will focus on understanding the
structure and organization of a WordPress theme and how to modify the
code to add custom functionality. This includes creating custom post types
and taxonomies, which allow for greater flexibility and organization in the
management of website content.

>

Additionally, we will explore the concept of child themes and advanced
customizations to a parent theme without affecting the original code. This



allows for easier maintenance and upgrades to the parent theme without
losing customizations. Lastly, we will cover the important skill of creating
custom page templates and understanding the use of template parts and
the loop to create dynamic pages. These skills will empower you to create
highly customized and functional WordPress themes.
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Wordpress Theme Structure & Organization

The structure and organization of a WordPress theme refers to how the
different files and templates within a theme are organized and interact
with one another.

A typical WordPress theme will have the following files:

- index.php (the main template file)

- header.php and footer.php (template parts for the header and footer of
the site)

- style.css (the main stylesheet for the theme)

- functions.php (a file that contains functionality specific to the theme)

- page.php and single.php (template files for individual pages and posts)

>

These files work together to create the overall design and functionality of
the theme. Understanding the structure and organization of a theme is
important because it allows developers to modify the code in a way that is
clean, organized, and maintainable.

>

### Custom Post Types

For example, in order to add custom functionality to a theme, a developer
may create a custom post type. Custom post types allow for the creation of
new types of content in WordPress, such as a “books” post type, which can
have its own set of fields and templates.

>

Another example would be creating a custom taxonomy like “genre” for the
book’s post type. This will allow the developer to group books by genre and
make it easy to filter and display.

>

By understanding the structure and organization of a WordPress theme,
and being able to modify the code, developers can add custom functionality
that makes a website more dynamic, efficient and tailored to the specific
needs of the client.

>

Exercise 1: Create a Custom Post Type
>

To create a custom post type, follow these steps:
>

1. Open your theme’s “functions.php” file or your child theme’s



“functions.php” file.
2. Add a function to register the custom post type. In this example, we will
create a custom post type called “Events”:

function my_custom_post_type_events() {
$labels = array(

'name' => 'Events',
'singular_name' => 'Event',
'add_new' => 'Add New',
'add_new_item' => 'Add New Event',
'edit_item' => 'Edit Event',
'new_item' => 'New Event',
'view_item' => 'View Event',
'search_items' => 'Search Events',
'not_found' => 'No events found',
'not_found_in_trash' => 'No events found in Trash',

DK

$args = array(
'labels' => $labels,
'public' => true,
'has_archive' => true,
'rewrite' => array('slug' => 'events'),
'supports' => array('title', 'editor', 'thumbnail',
'custom-fields', 'excerpt'),
);

register_post_type('events', $%$args);
}

add_action('init', 'my_custom_post_type_events');

3. Save the changes to the “functions.php” file.
4. Go to your WordPress dashboard, and you should now see the “Events”
custom post type in the left-hand menu.
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W

A child theme is a theme that inherits the functionality and styling of
another theme, called the parent theme. By using a child theme, developers
can make advanced customizations to a parent theme without affecting the
original code. This allows for easier maintenance and upgrades to the
parent theme without losing customizations.

Creating a child theme is relatively simple. A child theme only needs a
couple of files to work:

- style.css

- functions.php

>

The style.css file is used to add custom CSS styles, while the functions.php
file is used to add custom functions.

>

For example, a developer might want to make changes to the layout of the
site by modifying the parent theme’s CSS. Instead of editing the original
stylesheet, the developer can create a child theme and add the custom CSS
to the child theme’s stylesheet. This way, when the parent theme is
updated, the customizations will not be lost.

>

Another example would be if the developer wants to add a new widget
area to the sidebar. Instead of modifying the parent theme’s functions.php



file, the developer can create a child theme, and add the new widget area to
the child theme’s functions.php file.

>

By using a child theme, developers can make advanced customizations to a
parent theme without affecting the original code, allowing for easier
maintenance and upgrades to the parent theme without losing
customizations.
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When you download or purchase a Wordpress theme, a child theme
usually comes with it. The developer usually lets you know where you can
download it in the documentation.

>

There are a few other ways to get a child theme for WordPress:

>

WordPress Repository: The WordPress repository has a wide variety of
child themes that can be easily installed and activated from the WordPress
Dashboard. You can go to Appearance > Themes and search for “Child
Theme” and you will find a list of child themes that can be easily installed
and activated.

Exercise: Create a Child Theme

>

In this exercise, you will create a child theme for your WordPress site.

>

1. Create a new folder on your local machine named “my_child_theme”.

2. Inside the folder, create two new files called “style.css” and
“functions.php”.

3. Open the “style.css” file and add the following code:

>

/*
Theme Name: My Child Theme
Template: my_custom_theme
*/



Replace “my_custom_theme” with the name of your parent theme’s folder.
4. Save the “style.css” file.
5. Open the “functions.php” file and add the following code:

<?php
function my_child_theme_enqueue_styles() {
$parent_style = 'parent-style';
wp_enqueue_style($parent_style, get_template_directory_uri()
'/style.css');
wp_enqueue_style('child-style',
get_stylesheet_directory_uri() . '/style.css',
array($parent_style), wp_get_theme()->get('Version'));
}
add_action('wp_enqueue_scripts',
'my_child_theme_enqueue_styles');

6. Save the “functions.php” file.

7. Upload the “my_child_theme” folder to your WordPress theme directory
(wp-content/themes)).

8. Go to your WordPress dashboard and navigate to Appearance >
Themes. You should now see the “My Child Theme” available to
activate.
>
Always be sure to check the compatibility of the child theme with the
version of Wordpress you’re using and also check the reviews and
ratings of the child themes before installing and using it.
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In WordPress, a page template is a specific type of template file that can be
applied to a page or a group of pages to change their layout and design.
Custom page templates allow developers to create unique layouts for
different pages on a website.

>

For example, a developer might want to create a custom page template for
the homepage that has a different layout from the rest of the pages on the
site. The developer can create a new file in the theme’s directory called
“homepage-template.php” and assign it as a template for the homepage.

>

In addition to custom page templates, WordPress also allows developers to
use template parts and the loop to create dynamic pages.

>

Template parts are small reusable chunks of code that can be included in
multiple templates.

>

For example, a developer might create a template part for the header and
footer of the site, and include that template part in every template file. This
way, if the developer wants to make a change to the header or footer, the
change only needs to be made in one place, rather than in every template
file.

>

For example, your “header.php” file might look like this:



<IDOCTYPE html>
<html <?php language_attributes(); ?>>
<head>
<meta charset="<?php bloginfo( 'charset' ); ?>">
<meta name="viewport" content="width=device-width, initial-
scale=1.0">
<title><?php wp_title(); ?></title>
<?php wp_head(); ?>
</head>
<body <?php body_class(); ?>>
<header>
<!-- header content goes here -->
</header>

In each of your template files (e.g. index.php, single.php, archive.php),
where you want to include the header and footer, use the
get_template_part() function to include the template part. For example, in
your “index.php” file, you might have:

<?php get_header(); ?>
<!-- index content goes here -->

<?php get_footer(); ?>

By using template parts, you can avoid duplicating code and make your
theme easier to maintain and update in the future.

>

The loop is a code construct that is used to display the content of a page or
post. The loop retrieves the content from the database and displays it in the
template file. By using the loop, developers can create dynamic pages that
display different content based on the context of the page.

>

For example, a developer might create a custom template for a blog archive
page that uses the loop to display the titles and excerpts of the most recent
posts. The developer can also use conditional statements to display
different content on the page depending on whether the user is on the
homepage, an archive page, or a single post.

>

By understanding how to create custom page templates, and how to use
template parts and the loop, developers can create dynamic and
customized pages that can be tailored to the specific needs of the website.
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Conclusion & Takeaways

WordPress themes are crucial for successful, high-converting websites.
Their development requires knowledge of the theme’s structure,
customizing code for extra functionality, and creating child themes to allow
advanced tweaks without affecting the base code. Key components include
understanding the main template file, custom post types, and taxonomies
for a more dynamic site. Developers can download a child theme or create
their own with necessary files from the WordPress repository, always
ensuring compatibility and good reviews. This knowledge enables
developers to create customized, functional WordPress themes.
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Wordpress Plugins

Goals

By the end of this case you will:

- Understand the benefits and uses of WordPress plugins

- Learn the recommended method for editing a plugin in WordPress
- Explore the process of customizing a plugin

>

### Introduction

3
©

>

WordPress plugins are PHP scripts that enhance the functionality of a
WordPress website. They can be easily installed and activated from the
WordPress plugin repository and provide a range of features including
creating contact forms, optimizing a website for search engines, creating an
online store, improving website performance and security, and more.

>

Editing a plugin in WordPress involves making changes to its source code,
whereas customizing a plugin involves modifying its behavior without
changing the source code. In this module we’ll be going into more detail on
how you can use plugins to help you achieve your website goals.
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Wordpress Plugins

By now we know WordPress plugins are a powerful tool that can greatly
enhance the functionality and capabilities of a WordPress website. They
are written in the PHP programming language and can be added to a
WordPress website to provide additional features and functionality.

>

Plugins are designed to work seamlessly with the WordPress platform, and
are typically easy to install, activate, and configure. They can be found in
the WordPress plugin repository, which can be accessed from the
WordPress dashboard by navigating to the “Plugins” menu, and then
selecting “Add New.”

>
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One of the most popular and widely used plugins is the “Contact Form 7”
plugin, which allows users to easily create and manage contact forms on
their website. You will recall that we used this plugin to create a simple
contact form on your personal website last week. Another popular plugin is



“Yoast SEO,” which helps to optimize a website for search engine rankings
and provides tools for analyzing a website’s content and structure.

>

Another useful plugin is the “WooCommerce” plugin which allows you to
create an online store on your website. Using “WooCommerce” you can
manage products, orders, and customers. It’s one of the most popular e-
commerce plugins for WordPress.

>

Plugins can also be used to improve the performance and security of a
website. For example, the “W3 Total Cache” plugin can improve the loading
speed of a website by caching pages and posts, while the “Wordfence
Security” plugin can help protect a website from hacking attempts by
monitoring and blocking suspicious activity. You will recall that we
configured the Wordfence Security plugin on your personal website.

>

It’s important to note that not all plugins are created equal. Some plugins
may be poorly written and can cause conflicts with other plugins or the
theme. It is important to research a plugin before installing it, and to only
use plugins from reputable sources. Additionally, it’s also important to keep
your plugins up-to-date to ensure that they are still compatible with the
latest version of WordPress and that they have the latest security patches.
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Editing Plugins

Editing a plugin in WordPress can be done in a few different ways, and the
method you choose will depend on your specific needs and the type of
plugin you’re working with. Here are a few steps to help you get started:

>

1. Make a backup of your WordPress site before making any changes to a
plugin - Editing a plugin in WordPress involves making changes to the
plugin’s code to modify its behavior. Before making any changes, it is
important to make a backup of your WordPress site to protect your data.
You can create backups using a plugin, your cpanel or speak to your
hosting provider. You can go here and follow instructions to install a plugin
called UpdraftPlus which will allow you to backup your Wordpress for free.
>

2. Identify the specific plugin you want to edit, and find its code files.
Plugins are stored in the “wp-content/plugins” directory of your WordPress
installation - Editing a plugin in WordPress involves making changes to the
plugin’s code to modify its behavior. Before making any changes, it is
important to make a backup of your WordPress site to protect your data.

>

.. Wp-activate.php .. index.php .. index.php

=7 wp-admin < = mu-plugins > 7 wp-file-manager >
.. Wp-blog-header.php 8 plugins 5 7 wp-staging >
... Wp-comments-post.php ™ themes >

.. wp-config-sample.php T upgrade >

... wp-config.php = uploads >

~ wp-content >

... Wp-cron.php

= wp-includes >

wp-links-opml.php
wp-load.php
wp-login.php
wp-mail.php
wp-settings.php
wp-signup.php
wp-trackback.php
xmlrpc.php

3. Decide whether you want to edit the plugin files directly or create a child
plugin - There are two ways to edit a plugin in WordPress: editing the
plugin files directly or creating a child theme and editing it in there.
Directly editing the plugin files is not recommended because the
changes will be lost when the plugin is updated.


https://themeisle.com/blog/backup-a-wordpress-site-for-free/#gref
https://developer.wordpress.org/themes/advanced-topics/child-themes/

>
4. Once you’ve made your changes, save the file and activate the child
plugin in your WordPress dashboard.

Customizing a Plugin

Now that we know editing a plugin refers to making changes directly
to the source code of the plugin let’s take a look at how to customize a
plugin. Customizing a plugin involves modifying the behavior of the
plugin without changing its source code. This can be done by creating
a child plugin that interacts with the original plugin using the
WordPress API. Customizing a plugin in this way has the advantage
of allowing you to make changes that persist even after updating the
original plugin, as the changes are stored in a separate plugin.

Like we learnt earlier you can use actions and filters to modify the
behavior of the plugin: The WordPress API provides two functions for
customizing plugins:

1. add_action - actions allow you to add new functionality to a plugin.

2. add_filter - filters allow you to modify existing functionality.

Exercise:
Here’s an example of how to use add_filter to change the text of a
button in a plugin called “Contact Form”:

<?php

/*

Plugin Name: My Custom Contact Form
Description: A child plugin that modifies the text of the button
in the Contact Form plugin.
*/

function my_custom_contact_form_modification() {
add_filter( 'contact_form_button_text',
'change_contact_form_button_text' );

}

function change_contact_form_button_text() {

return 'Send';

add_action( 'init', 'my_custom_contact_form_modification' );

In this example, the my_custom_contact_form_modification function uses
the add_filter function to modify the text of the button in the “Contact
Form” plugin. The text of the button will now be changed to “Send”.

>

By following these steps, you can customize a plugin in WordPress to fit



your specific needs. However, it’s important to keep in mind that modifying
a plugin’s code can have unintended consequences, so be sure to test your
changes thoroughly before deploying them on a live site.

>

Exercise #2:

Optimize Contact Form 7 by Loading JavaScript and Stylesheet Only
When Necessary

>

Objective: In this exercise, you will learn how to load Contact Form 7’s
JavaScript and stylesheet only on pages containing contact forms, rather
than on every page.

>

Step 1: Disable JavaScript and CSS loading for Contact Form 7 on all pages
1.1 Open your wp-config.php file and add the following lines:

define( 'WPCF7_LOAD_JS', false );
define( 'WPCF7_LOAD_CSS', false );

Alternatively, add these lines to your theme’s functions.php file:

add_filter( 'wpcf7_load_js', '__return_false' );
add_filter( 'wpcf7_load_css', '__return_false' );

Step 2: Enable JavaScript and CSS loading for Contact Form 7 only on pages
containing contact forms

2.1 Identify the template file for the page containing the contact form (e.g.,
contact.php).

2.2 Open the template file and add the following lines of code before the
wp_head() function call:

<?php

if ( function_exists( 'wpcf7_enqueue_scripts' ) ) {
wpcf7_enqueue_scripts();

}

if ( function_exists( 'wpcf7_enqueue_styles' ) ) {
wpcf7_enqueue_styles();

?>
After completing these steps, Contact Form 7’s JavaScript and stylesheet

will only load on the pages containing contact forms, improving the overall
performance of your WordPress site.
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Conclusion & Takeaways

In conclusion, WordPress plugins can be edited or customized to enhance
their functionality. Editing involves making changes directly to the source
code, while customizing involves modifying the behavior of the plugin
without changing the source code. The recommended method for editing a
plugin is creating a child plugin, which allows you to make changes that
persist even after updating the original plugin. With the power of the
WordPress API and a child plugin, customizing a plugin in WordPress has
never been easier, but remember to always backup your site for a seamless
and safe experience."
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Wordpress File Structure and Security

Goals

By the end of this case you will:

- Understand the organization and structure of WordPress files and folders.
- Know the location of theme and plugin files within the WordPress file
structure.

- Become aware of the benefits of limiting the number of plugins used,
including improved security, compatibility, load times, and maintenance.

o
—"

### Introduction

A

The WordPress file structure is the foundation of a WordPress website and
plays a crucial role in determining its overall functionality, performance
and security. Understanding the basics of the WordPress file structure is an
essential step towards building and maintaining a successful website.
Know where the files that you need are; understand the importance of not
bloating your site with plugins and add-ons. A firm grasp of basic
WordPress file structure, and incorporating essential security measures,
will ensure the overall success and protection of a WordPress website.
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Basics of Wordpress File Structure

Since we want to be able to view our file structure first, let’s set up a way to
get there through our WP-Admin section. In the previous modules we
downloaded LocalWP to install Wordpress so now we will open that up and
go to our Wordpress site that we set up locally, login using our username
and password and go to the WP admin section.

>

Now let’s download a plugin that will allow us to view our files.
>

1. Click on Plugins in the left vertical bar in your WP-Admin section

\":" # test-site

§% Dashboard

A Posts
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Add New
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Settings

Q cC se menu

2. Click add new at the top

Plugins

3. In the search bar on the right we will type in file manager and the results
will load.
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4. Let’s install the first one on the left called ‘File Manager’. Click Install
Now and then Activate once it’s done installing.
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5. Once you click ‘Activate’ it will bring you to your plugins page and you
will also see it on the left side vertical WordPress menu. Now when you
click on the plugin it will bring you to your main screen, showing you the
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Understanding Wordpress Files

Now let’s take a deeper dive into the main fol
2L P L

wp-admin

wp-content

wp-includes

ders that we see on the left.

The main folders are the public directory folder, wp-admin, wp-content

and wp-includes.

### The Public Directory Folder

i wp-admin
I8 wp-content

B wp-includes

‘htaccess

index.php
license. txt
local-xdebuginfo.php

@ readme.html
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wp-activate.php
wp-blog-header.php
wp-comments-post.php
wp-config-sample.php
wp-config.php
wp-cron.php
wp-links-opml.php
wp-load.php
wp-login.php

Permissions
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
read and write
public
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The public folder is the root directory of a WordPress website. It contains
the main index.php file, which serves as the entry point for all requests to
the website.
### The wp-admin Folder



Permissions Modified

Nov 15, 2022 02:03 PM read and write Nov 15, 2022 02:03 PM
images read and write Nov 15, 2022 02:03 PM
includes read and write Feb 03, 2023 02:18 PM
is read and write Nov 15, 2022 02:03 PM
maint read and write Nov 15, 2022 02:03 PM
network read and write Nov 15, 2022 02:03 PM
user read and write Nov 15, 2022 02:03 PM

#| about.php read and write Nov 15, 2022 01:50 PM

#] admin-ajax.php read and write May 07, 2022 12:21 PM

# admin-footer.php read and write Jun 01, 2021 07:30 AM

#| admin-functions.php read and write Feb 06, 2020 01:33 AM

#| admin-header.php read and write Apr 04, 2022 02:39 PM

#| admin-post.php read and write Mar 02, 2022 10:00 AM

#/ admin.php read and write Apr 04, 2022 02:43 PM

#| async-upload.php read and write Jan 27, 2022 05:17 PM

#| authorize-application.php read and write Aug 04, 2022 10:52 AM

# comment.php read and write Mar 22, 2022 12:25 PM
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Size

34 KB
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12 KB
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Folder
Folder
Folder
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PHP source
PHP source
PHP source
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PHP source
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Items: 99, Size: 886 KB 4

The wp-admin folder contains the files that power the WordPress
dashboard. It is the backend of a WordPress website and is used to manage
content, install plugins, and customize the appearance of a website. The
wp-admin folder is not publicly accessible and is only accessible by users

with administrator-level access.
### The wp-content Folder

Permissions Modified
plugins read and write Today 12:54 PM
themes read and write Nov 15, 2022 02:03 PM
upgrade read and write Today 12:54 PM
uploads read and write Today 12:54 PM
#] index.php read and write Jan 08, 2012 12:01 PM
wp-content

Size

Kind

Folder
Folder
Folder
Folder

PHP source

Items: 5, Size: 28 b 4

The wp-content folder is the most important folder in a WordPress
installation. It contains all the files that make up the look and feel of a
website, including themes, plugins, and media files. The wp-content folder
is publicly accessible and is the place where most customization and

development work is done.
### The wp-includes Folder

Permissions Modified
assets read and write Nov 15, 2022 02:03 PM
block-patterns read and write Nov 15, 2022 02:03 PM
block-supports read and write Nov 15, 2022 02:03 PM
blocks read and write Feb 03, 2023 02:18 PM
certificates read and write Nov 15, 2022 02:03 PM
css read and write Nov 15, 2022 02:03 PM
customize read and write Nov 15, 2022 02:03 PM
fonts read and write Nov 15, 2022 02:03 PM
D3 read and write Nov 15, 2022 02:03 PM
images read and write Nov 15, 2022 02:03 PM
IXR read and write Nov 15, 2022 02:03 PM
is read and write Nov 15, 2022 02:03 PM
php-compat read and write Nov 15, 2022 02:03 PM
PHPMailer read and write Nov 15, 2022 02:03 PM
pomo read and write Nov 15, 2022 02:03 PM
random_compat read and write Nov 15, 2022 02:03 PM
Requests read and write Nov 15, 2022 02:03 PM

wp-includes

Size

Kind

Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder
Folder

Items: 248, Size: 6.45 MB 4

The wp-includes folder contains the core WordPress files and libraries. It is
not publicly accessible and is used by WordPress to run the website. The
wp-includes folder contains a variety of files, including functions, classes,
and scripts that are used by WordPress to process requests and generate

output.

>
Exercise:
>



Try accessing each of the four main folders in your WordPress installation
and examine the contents of each folder. Write a short description of the
purpose of each folder and what types of files are stored in each folder. In
your answer include a file that you find in each of the folders. (Example:
the public directory contains the wp-config file that holds critical settings
and information for a WordPress site, the wp-includes folder contains
images folder where all images are stored etc.)



Understanding location of
important files

Understanding the location of important files

Public Folder Important Files

The public folder in WordPress is known as the root directory and is the
first thing that is loaded when someone accesses your website. In this
folder, you’ll find all the files that are publicly available to visitors of your
website, such as:

- index.php file - the main file in the public folder and acts as the central
hub for all requests to your website. When someone visits your website,
their browser sends a request to the server for the index.php file. The file
then loads the WordPress core and begins to process the request.

- .htaccess file - used to configure server-side settings such as redirects,
URL rewrites, and security settings. It’s important to be cautious when
modifying the .htaccess file as even a small mistake can cause your website
to become inaccessible.

- wp-config.php - contains all of the site’s configuration details and settings
>

Exercise: Increasing WordPress memory limit by editing the wp-
config.php file.

>

Step 1: Locate the wp-config.php file

The wp-config.php file is located in the root folder of your WordPress
installation. You can access it through your hosting control panel or by
using an FTP client.



public i .| Wp-activate.php

T2 wp-admin >

e &

sql >
.| Wp-blog-header.php

... Wp-comments-post.php

.| wp-config-sample.php

B wp-config.php

T wp-content >
.| Wp-cron.php
= wp-includes p

.| Wp-links-opml.php
.| wp-load.php

.| Wp-login.php

... wp-mail.php

.| Wp-settings.php
.| Wp-signup.php

.| wp-trackback.php
.| Xmlrpc.php

Step 2: Open the wp-config.php file for editing

Using your hosting control panel’s file manager or an FTP client, open the
wp-config.php file in a text editor.

Step 3: Increase memory limit

Find the line that says:

define( 'WP_MEMORY_LIMIT', 'XXM' );

Replace XX with the desired memory limit in megabytes (e.g., 128, 256, or
512). If the line does not exist, you can add it just before the line that says /*
That’s all, stop editing! Happy publishing. */.

>

For example, to set the memory limit to 256 MB, add or modify the line like
this:



if ( ! defined( 'WP_DEBUG' ) ) {
define( 'WP_DEBUG', false );

1
I

define( 'WP_MEMORY_LIMIT', '256M' );

For example, to set the memory limit to 256 MB, add or modify the line like
this:

>

Step 4: Save and close the file

Save your changes to the wp-config.php file and close the text editor.

>

Step 5: Verify the increased memory limit

You can check your WordPress site’s memory limit by visiting the “Tools” ->
“Site Health” page in the WordPress admin dashboard.



& Tools

Available Tools
Import

Export

Site Health (1
Export Personal Data

Erase Personal Data

Under the “Info” tab, click on “Server” and find the “PHP memory limit”
entry.
Site Health

Should be improved

Status Info




Server A

The options shown below relate to your server setup. If changes are required, you may need your web host's assistance.

Server architecture Darwin 21.6.0 x86_64

Web server nginx/1.16.0

PHP version 8.1.9 (Supports 64bit values)
PHP SAPI fpm-fegi

PHP max input variables 4000

PHP time limit 1200

PHP memory limit 256M

Max input time 600

Upload max filesize 300M

PHP post max size 1000M

cURL version 7.84.0 (SecureTransport) OpenSSL/1.1.1q
Is SUHOSIN installed? No

Is the Imagick library available? Yes

Are pretty permalinks supported? Yes

.htaccess rules Your .htaccess file contains only core WordPress features.

Now, you've successfully increased the memory limit in the wp-config.php
file.

>

### WP-Admin Folder Important Files

The wp-admin folder is the heart of the administrative side of your
WordPress site. This folder contains all the necessary files for the
WordPress dashboard, where you can manage the appearance, settings,
and content of your site. Some of the key files you’ll find in the wp-admin
folder include:

- The index.php file: it is the entry point for the WordPress dashboard.

- The admin-ajax.php file: handles all of the AJAX requests for the
WordPress dashboard.

- The CSS folder: contains all of the stylesheets for the WordPress
dashboard.

- The images folder: contains all of the images used in the WordPress
dashboard.

>

### WP-Content Folder Important Files

Now we know that the wp-content folder is the most important folder for
your WordPress site, because that’s where all of your content, plugins, and
themes are stored. Some of the key files you’ll find in the wp-content folder
include:

- The plugins folder: which contains all of the plugins you have installed
on your site.

- The themes folder: which contains all of the themes you have installed
on your site.

- The uploads folder: which contains all of the media files you’ve uploaded

to your site.
>






Plugins Exploration

Exercise: Making the connection between files and file explorer

Plugins Exploration:

1. Navigate to the Plugins section (Plugins > Installed Plugins) in the
WordPress dashboard.

2. Make a note of a few of the names of the installed plugins.

3. Use an FTP client or a file manager to access the wp-content folder and
open the plugins folder. (If you’re using LocalWP you can click on ‘Go to
site folder’ (see screenshot) or if you want to use Wordpress CMS you can
download the ‘File Manager’ plugin.

test-site -

23 Open site shell

Overview Database Tools

4. Match the plugin folders in the file explorer with the plugin names noted
from the WordPress dashboard. Identify at least one PHP file within each
plugin folder that corresponds to the plugin’s functionality.

>

Themes Exploration:

1. Navigate to the Themes section (Appearance > Themes) in the WordPress
dashboard.

2. Make a note of the active theme and any other installed themes.

3. Access the wp-content folder and open the themes folder using the file
explorer.

4. Match the theme folders in the file explorer with the theme names noted
from the WordPress dashboard. Identify the “style.css” and “functions.php”
files within each theme folder, which are essential for each theme’s
appearance and functionality.

>

### Media Files Exploration:

1. Navigate to the Media section (Media > Library) in the WordPress
dashboard.

2. Choose one or two media files and note their file names and upload



dates.

3. Access the wp-content folder and open the uploads folder using the file
explorer.

4. Locate the media files you noted earlier in the appropriate subfolders
(organized by year and month) within the uploads folder. Observe the
correlation between the media files displayed in the dashboard and the
files stored in the uploads folder.

>

### WP-Includes Folder Important Files

Finally, the wp-includes folder contains all of the core files for the
WordPress platform. This folder is not intended for customization, as any
changes you make here could be overwritten during a WordPress update.
Some of the key files you’ll find in the wp-includes folder include:

- The wp-db.php file: contains all of the database functions for WordPress.
- The wp-load.php file: is the first file loaded when a page is accessed on
your site.

- The wp-settings.php file: contains all of the settings for your WordPress
site.

>



Wordpress Security

Wordpress Security

WordPress is the most popular content management system and powers
over 40% of the world’s websites. As with any popular software, it is
important to ensure that your WordPress site is secure and protected
against potential threats. In this section, we’ll discuss the importance of
WordPress security and introduce two popular plugins for improving your
site’s security: WordFence and WPS Hide Login.

>

### WordPress Security

WordPress security is a critical aspect of website ownership. Your site’s
security affects not only your own website, but also your users and
customers. If your site is compromised, it can result in loss of data, damage
to your reputation, and harm to your users. Some common WordPress
security threats include hacking attempts, malware infections, and
unauthorized access to sensitive information.

>

To protect against these threats, it’s important to follow best practices for
WordPress security, such as keeping your software up to date, using strong
passwords, and limiting the number of plugins you install. Speaking of
plugins, you can use specific plugins to help secure your Wordpress site.
Two popular plugins are Wordfence and WPS Hide Login.

>

### Wordfence Plugin

https://www.wordfence.com/

As we saw last week, Wordfence is a comprehensive security plugin that
provides many different types of security features for a WordPress site.
One of the key features of Wordfence is its firewall, which provides real-
time protection against hacking attempts and malicious traffic.
Additionally, Wordfence scans the website for vulnerabilities and can alert
the site owner if any are found. The plugin also has a feature that limits
login attempts, preventing hackers from guessing passwords. Furthermore,
the Pro version of Wordfence provides a country blocking feature, which
allows site owners to block traffic from specific countries if needed.

>

### WPS Hide Login Plugin
https://en-cawordpress.org/plugins/wps-hide-login/

WPS Hide Login is a plugin that helps to protect the WordPress site from
brute force hacking attempts by changing the default login URL. This helps
to prevent hackers from finding the login page and trying to guess the
password. WPS Hide Login also provides a feature to log failed login
attempts, allowing site owners to monitor any suspicious activity.



Additionally, the plugin has an option to change the WordPress error
messages, which can help to make it harder for hackers to determine if

they have guessed a valid username or password.
>

Once you install it and go to settings you will see the following:

WPS Hide Login

Need help? Try the support forum. This plugin is kindly brought to you by WPServeur (WordPress specialized hosting)
Discover our other plugins: the plugin WPS Bidouille, the plugin WPS Cleaner and WPS Limit Login

Login url http://test-site.local/ | login /

Protect your website by changing the login URL and preventing access to the wp-login.php page and the wp-admin directory to non-connected people.

Redirection url http://test-site.local/ | 404 £

Redirect URL when someone tries to access the wp-login.php page and the wp-admin directory while not logged in.

You can change the URL so it’s not wp-login.php and you can name it
whatever you want. If you want to create a redirect if someone does try to

access this URL if they’re not logged in you can create that in the second
box as well.



Conclusion & Takeaways

Conclusion & Takeaways

In conclusion, the WordPress file structure is a critical aspect of any
WordPress website that affects its overall functionality, performance, and
security. Understanding the basics of the file structure is crucial in building
and maintaining a successful website. It involves knowledge of the location
of important files, the importance of avoiding bloating the site with
excessive plugins, and incorporating essential security measures to protect
the site from potential threats. By taking the necessary steps to understand
the WordPress file structure and implement necessary security measures,
one can ensure the overall success and protection of their WordPress
website.

>
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>
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Website Management Tools

Website Management Tools

Google Analytics

Goals:

Monitor website traffic: visitors, source, viewed pages

Track marketing campaign impact: see which drives traffic/conversions
Improve website conversions: analyze user behavior for improved
navigation/UX

Make informed decisions: use data from Google Analytics for
optimization, ad spending, and marketing strategy

Measure website success: track bounce rate, time on site, and goal
conversion rate for improvement

>
### Introduction

Google
.. Analytics

Google Analytics is a free web analytics tool offered by Google that is
used to track and analyze website traffic. It provides businesses with
valuable insights into the performance of their website, helping them to
understand their target audience and optimize their online presence.

>

By using Google Analytics, businesses can monitor website traffic,
understand user behavior, and track conversions, enabling them to
make data-driven decisions to improve the user experience and drive
more traffic to their website.



Overview of Google Analytics

Overview of Google Analytics

Google Analytics is a powerful tool that can track various metrics related to
a website’s traffic, such as the number of visitors, their location, and the
pages they visit. The tool provides data in real-time, making it easy to
monitor the performance of a website and take necessary actions to
improve it.

>

#A Home
Google Analytics Home
» &7 Customisation
Users Sessions Bounce Rate Session Duration Active users in last five minutes
9
0 0 0% O0m 00s

REPORTS
» © Real-time
» & Audience
» 3+ Acquisition
» B Behaviour

» M Conversions

No data available

Last7 days v UDIENCE OVERVIEW > REAL-TIME REPORT >

Google Analytics offers a range of features that allow you to get a
comprehensive view of your website’s performance and user behavior.
Some of the key benefits of using Google Analytics include:

e Traffic analysis: You can see how many people are visiting your
website, where they are coming from, and what pages they are viewing.
This data can help you understand the effectiveness of your marketing
campaigns and make decisions about adjusting your advertising spend.

e User behavior tracking: Google Analytics tracks the behavior of your
website visitors, including how long they spend on your site, what
pages they visit, and what actions they take. This information can help
you identify areas for improvement in your website’s user experience,
resulting in higher conversion rates.

e Conversion tracking: You can set up conversion goals in Google
Analytics to track the actions that are important to your business, such
as sign-ups, purchases, or downloads. By analyzing the data, you can
see how well your website is converting visitors into customers.

® Custom reporting: Google Analytics provides a wide range of
customizable reports, allowing you to analyze data in the way that
makes the most sense for your business. You can create custom reports
that show the data that is most important to you and share these
reports with your team.

® Mobile optimization: Google Analytics tracks website traffic and user
behavior across both desktop and mobile devices, allowing you to see



how your website is performing on different platforms. This
information can help you make informed decisions about optimizing
your website for both desktop and mobile users.

>

#i## Setting up Google Analytics

Setting up Google Analytics on a website is a straightforward process.
First, create a Google Analytics account, then add the tracking code to
the website. This code is a snippet of JavaScript that needs to be placed
on every page that you want to track. The tracking code can be added
manually or through plugins available for popular content
management systems like WordPress.

>

Steps:

>

1. Create a Google Analytics account:

e First you go to https://analytics.google.com/analytics/web/ and it will
redirect you to sign in to your Google account.

® Once you sign in, it will bring you to the ‘Welcome’ page. Click ‘Start
Measuring’.

Al Analytics

Welcome to Google Analytics

Google Analytics gives you the free tools you need to analyze data for your business in one place, so you can
make smarter decisions.

Complete information

Understand your site and app users to better check the performance of your
marketing, content, products, and more.

Get insights only Google can give

Access Google's unique insights and machine learning capabilities to make the

most of your data. ‘ -
Connect your insights to results

Analytics works with Google's advertising and publisher products, so you can use

your insights to deliver business results.

© 2023 Google | Analytics home | Terms of Service | Privacy Policy | (3 Send feedback

e Next you will be required to create an ‘Account Name’, fill this in.

o Account setup

Account details

Account name (Required)

Accounts can contain more than one tracking ID.

correlation-one-test

® Next you can pick and choose your desired settings for data sharing



Account Data Sharing Settings @

afidertial This dat i used to maintan and protect the G

‘The data sharing options give you more control over sharing your Google Analytics data. Learn more

[0 Google products & services
ityor

Benchmarking
Cont

and publications that can help you understand data trends. Allidentifiable information about your websit
with other

e is removed and combined

Technical support
Let Google technical support representatives access your Google Analytics data and account when n

Account speciali
Give Google m

r configuration and analysis, and share optimization tips with you. If

Learn how Google An

® Next is ‘Property Setup’ . This is where you can input your website or
app’s name. This is the name of the Google Analytics account for a
particular website so name it something useful like the website domain
name or the company name.

o Property setup

Property details

A property represents a business's web and/or app data. An account can contain one or more properties. Learn more
*Navigate to your Firebase account if you want to create & new property for an existing Firebase project.

Create a Google Analytics 4 property to measure your web and/or app data.

Property name

correlation-one-test

Reporting time zone

United States ~ (GMT-08:00) Los Angeles Time ~

Currency

US Dollar (8) ~

You can edit these property details later in Admin

Show advanced options

m Previoys

e Next you can answer some questions about your business or the reason
you need the analytics account



o About your business

Business information

Help us tailor your experience by answering the following.
Industry category

Business & Industrial ~

Business size

@ Small - 1 to 10 employees

O Medium - 11 to 100 employees
O Large - 101 to 500 employees
O Very Large - 501+ employees

How do you intend to use Google Analytics with your business? (Check all that apply)
Measure customer engagement with my site or app

Optimize my site or app experience

Measure data across multiple devices or platforms

Optimize my advertising cost

Increase my conversions

Measure content monetization

Analyze my online sales

Measure app installs

Measure lead generation

Ol Q

Other

® Once you’re done click ‘Create’.
Now you’ve got your first Google Analytics account!

Integrating script in your website header to start collecting data.
>

On the left hand side of your GA dashboard you will see at the bottom
‘Admin’. Click on that.



%, Attribution >
Q Discover

£ Admin

o+

Under the ‘Property’ column, click on ‘Tracking Info’
Aceount Property View
Portfolio v Uzair Danish (UA-97342111-1) v All Web Site Data

B AccountSettings GA4 Setup Assistant B View Settings

422 Account Access Management [ Property Settings 482 View Access Management

Y AllFilters 222 Property Access Management M= Goals

D Account Change History <> » Tracking Info 2\ Content Grouping

W Rubbish Bin ) Property Change History Y Filters

Dd  Data Deletion Requests “] » Channel Settings

PRODUCT LINKS ™ E-commerce Settings

Once you click on Tracking Info, click on ‘Tracking Code’

< » ~ Tracking Info

Tracking Code

Data Collection

Data Retention

User-ID

Session Settings

Organic Search Sources
Referral Exclusion List
Search Term Exclusion List

You will be brought to the following screen with a script. This is the script
that you will input inside of your header tag on your website. If this is a
Wordpress website you can even download plugins like MonsterInsights or
GA Google Analytics which will make it easier for you to add the script
without having to go into the code.



Tracking ID Status
UA_97342‘| 1 ‘I_‘I No data received in past 48 hours. Learn more

Send test traffic

Website Tracking

Global Site Tag (gtag.js)

This is the Global Site Tag (gtag.js) tracking code for this property. Copy and paste this code as the first item into the <HEAD> of every web page that you want to track. If you already
have a Global Site Tag on your page, simply add the config line from the snippet below to your existing Global Site Tag.

<!~ Google tag (gtag.js) —>
<script async src="https://www.googletagmanager.com/gtag/js?id=UA-97342111-1"></script>
<script>

window.dataLayer = window.dataLayer || [

function gtag(){dataLayer.push(arguments);}

gtag(js', new Date());

gtag(‘config', 'UA-97342111-1);
</script>
2

The Global Site Tag provides streamlined tagging across Google’s site tracking and products - giving you better control while making

implementation easier. By using gtagjs, you will be able to benefit from the latest dynamic features and integrations as they become available. Learn more

PN ﬁ?np‘ectgq Site Tags

Now that you created your first account GA will walk you through where

things are:

1. Navigating to your reports

| 3 All accounts > correlation-one-test T hi “wh did
A Analytics | correlation-one-test - IR R B L

Navigate to reports
P g p

Use the side panel to navigate to different reports.

Click Reports.

® a

)

To set up data collection for your
ﬁ Property Settings

«ns Property Access
Management

2. Next you can see the overview of reports - this is where you can find
information about your users and what they do on your website - this
screen is where you will spend a lot of your time.

Allsccounte > coreltioncne test

.Il Analytics  correlation-one-test - Q@ Try searching *where did my users come from" nm e : |

A Roports snapshot © A { Asdcompioon + Lastz8dors Jan 13- Feb 9, 2023 ¥
Realtime

@ Reports snapshot © - @<~ 72
Lite cycle

Q it
> Acquisition

@ > Eengagement

> Monetization

Reports snapshot
Inthe .
View realtime > View all insights >
O Library igh

3. In the left column you will see the different reports that all have different
functions and highlight different types of user behavior on your website.



Reports snapshot e AllUsers | Add comparison +.:}

Realtime

Life cycle ~ Reports

e Different reports will help you learn about your busi
»  Acquisition ports v Ry ’

Start with one of several life reports that highlight key
»  Engagement information about your u behavior on your web and
These answer questio s How active are your usi
+ Monetization time?

Overview User reports help you understand your * demographics and
technology.

User ~

+  Demographics

¢+ Tech

4. Next you have ‘Explorations’. This is where you can see a range of
advanced methods for digging into customer behavior beyond standard
reports. They allow you to adjust and switch between different techniques
to uncover more comprehensive insights from your data.

(D Can't find any data streams. Please set up a stream to start collecting data in this property.

All accounts > correlation-one-test

.ll Analytics correlation-one-test ~ Q, Try searching "where did my users come from"

H Home 0 All Users

Gain a deeper understanding of your data with a series of advanced
@ Explore G i B G

technigues (ft worts, and more). Share your findings and

create audiences directly from your resu

Explorations x

@ Advertising
PRE

5. After that we have the advertising section where you can collect data and
insights related to advertising campaigns. This tab is specifically designed
for tracking the performance of your online advertising campaigns.

s All accounts » correlation-one-test 1 hi “oih s
Al Analytics  correlation-one-test - S TH semghing athiste <3 vl
ﬂ Home e All Users Addmmparlson

@ Explore Advertising X

Use attribution reports to better understand paths to conversion and
@ Advertising channel performance




6. At the bottom is the ‘Admin’ section where you can review and edit users,
property and account settings.

Review and edit your user, property, and account settings

Property editors can manage user permissions, configure data
retention and g settin nd edit product li ch as Google
Ads and Firebase).

£ Admin




Understanding Google Analytics
Reports

Understanding Google Analytics Reports

Google Analytics 4 (GA4) is a new version of Google Analytics that provides
insights about website and app user behavior. It is designed to work with
Google’s advertising and analytics products and provides new and
improved features that can help businesses better understand and engage
with their customers.

>

A GA4 report is a collection of data that provides insights into various
aspects of a website or app’s performance. It includes information about
user acquisition and behavior, such as acquisition channels, user
demographics, engagement metrics, and conversion rates. The report can
also provide information about user behavior on specific pages, such as
time on site, bounce rate, and pages per session.

>

Some of the types of reports available in GA4 include:

>

### Overview Report

This report serves as a broad overview of crucial metrics that provide an
understanding of the overall performance of your website or app. It
includes metrics such as the number of sessions, conversion rate, and
revenue, which are essential indicators of the health of your business.



O All Users
] L

Overview

or ¥S  Select a metric
® Users

0

100

) YJan 4 a a a a ) lan 12 J 14 Jar an 16 Ja an 18 Ja I a

Users New Users Sessions Number of Sessions per User = Page Views

1,962 1,835 2,458 1.25 8,881
Pages/Session Avg. Session Duration Bounce Rate

3.61 00:02:39 54.96%

(Smart, 2019)

### Audience Report

This report offers insights into the characteristics and behavior of your
audience, providing a better understanding of who they are and how they
interact with your website or app. This includes data on demographics,
interests, location, and behavior patterns, which can be used to inform and
guide your marketing strategies.

A Home jser Hourly | Day Week | Month
Custor ® User:
» @ Realtime T
~ & Audience 1000
e [TV —
" - —
e
13,035 10,876 119 d
Puiwiins [ S
o 84,429 5.44 4515%
» Geo e | o
e
oo
[—— Lamunge [
+ Motie
Language 1 8107 NN 6227%
Crossi
2 1203 W 9.23%
P .
city 3 05 | 311%
2, Attribution **" Syster 4. zhen 297 | 2.28%
Q  Discover 5 2o IBicey
e o e
£ Admin S

210 | 161%

Moz, 2021)

### Acquisition Report

The Acquisition Report helps you understand where your traffic is coming
from, providing data on various channels such as organic search, referral,
paid search, and more. This information can be used to optimize your
marketing and advertising efforts and drive more traffic to your site or app.



A Home

8 Customization Top Channels

REPORTS. ‘

» @ Realtime |
Display
2 Audience

Conversions

® Ecommerce Conversion Rate

T

2 enc (0ther) %W\__/-//_' N \/\/_
~ > Acquisition 1000 2008

» Search Console Acquisition Behavior Conversions
e N (i (T
- 13,035 10876 15510 4515% 544 00:03:09 3.47% 538 $30,825.67
» B Behavior

» M Conversions
2 m Paid Search 137 ‘ 81.88% _ 0.00%

2, Attribution ™
Q  Discover 5 m (Other) 20 sase [ 000%

% Admin To see all 5 Channels click here.

Moz, 2021)
### Behavior Report

The Behavior Report provides insights into how users are interacting with
your content, including metrics such as pageviews, bounce rate, and
average time on site. This information can be used to improve the user
experience and increase engagement with your website or app.

A Home © Pageviews

2000

5 Custo
REPORTS

» © Realtime

10000

» 2 Audience g2t e

» 3+ Acquisition

o e Pageviews Unique Pageviews Avg. Time on Page
S 84429 49,908  00:00:43

Overview —-
Behavior Flow
» Site Content
» site Speed
» Site Search

» Events

Experiments

» M Conversions

Moz, 2021)
>

### Conversion Report

A0z Aw2e A5 20

45.15% 1837%

[
11,636 W 1378%

ns/quickview @ s988 [ 7.09%

sgz7 [l 690%
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The Conversion Report is designed to help you understand the outcomes
that matter most to you. This includes data on transactions, conversion
rate, and revenue, which can be used to optimize your conversion funnel

and increase conversions.
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### Custom Reports

This feature allows you to create your own reports tailored to the metrics
and dimensions that are most important to you. This provides greater
flexibility and the ability to analyze data in a way that is most relevant to
your business.
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### Real-Time Report

The Real-Time Report provides real-time data on user activity, allowing you
to see the number of users currently on your site or app and what they are
doing. This information can be used to make informed decisions in real-
time and respond quickly to any changes in user behavior.

Overview Create Shortcut
Pageviews
Right now Per minute Per second
- >
active users on site -
B DESKTOP M MOBILE —_—— = - - ’ ‘
Top Referrals: Top Active Pages:

Source Active Users & Active Page Active Users &
9 6420%

1. analytics.google.com 1

1 74%
Top Social Traffic:

1 7.04%
Source Active Users v
7.14%
There is no data for this view
7.14%

Top Keywords: 7.14%

Keyword Active Users &
1. (not provided 10 TopLocations:
(Koks, 2018)
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Conclusion & Takeaways

Conclusion & Takeaways

Overall Google Analytics is a great website tracking tool that provides real-
time data on various metrics to help you understand user behavior on your
website. Setting it up is important and straightforward. The goal is to
integrate it with your site and start tracking everything along with
customizing reports to help you understand and find gaps in your website
so you can improve and optimize it. The latest version, Google Analytics 4,
offers improved features that provide even greater insights. Since it’s
always improving, the best way to learn is to start generating reports and
to be curious!

>
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SEO Score Checker

SEO Score Checker

Goals:

Understanding SEO score checker: definition and function

Outline factors affecting the website’s SEO score

Use score checker to analyze website performance: identify areas for
improvement

Prioritize improvement actions as a function of impact on SEO score
Realize the importance of generating a report of recommendations
effectively

Grasp the difference between mobile and desktop reports as well as the
importance of optimization for both

Track and monitor the progress of the website’s SEO score over time

>
### Introduction

SEO Score Checker is a tool used to evaluate the quality and
effectiveness of a website’s search engine optimization (SEO) efforts.
The tool analyzes various factors related to a website’s SEQO, such as its
content, keywords, meta tags, and backlinks. This tool also provides a
score that reflects the website’s overall SEO performance.

>

### Understanding SEO Score

An SEO Score is a numerical representation of a website’s SEO quality,
calculated by evaluating various SEO factors. A high SEO score indicates
that the website is well optimized for search engines and is likely to
rank well in search results. A low score, on the other hand, indicates

that the website needs improvement in its SEO efforts.
>



Steps to understanding SEO scores:
>
Familiarize yourself with the basics of search engine optimization
(SEO0): Before you can understand an SEO score, it’s important to have a
basic understanding of what SEO is and what it entails. Read up on the
various on-page and off-page factors that can impact a website’s search
engine performance. You can even run your own website or a website
of your choice through the following SEO checker:
https://www.seobility.net/en/seocheck/
Choose an SEO score checker: There are many SEO score checkers
available online, and each one may have a slightly different approach
to calculating scores. Choose one that you feel comfortable using and
that provides the information you need. Here’s a couple options to
choose from:

o Google Pagespeed Insights: https://pagespeed.web.dev/

o GTMetrix: https://gtmetrix.com/

o SEObility: https://www.seobility.net/en/seocheck/

o SEO Site Checkup: https://seositecheckup.com/

o Neil Patels’ SEO Analyzer: https://neilpatel.com/seo-analyzer/
Enter your website’s URL: Once you've chosen an SEO score checker,
enter the URL of the website you want to analyze. The score checker
will then analyze various elements of the website and provide you with
an SEO score.
Interpret the SEO score: SEO scores are usually represented as a
percentage or a numerical value on a scale (e.g., 1-100). The higher the
score, the better the website’s SEO performance. Keep in mind that
different score checkers may use different scales, so it’s important to
understand how your chosen checker calculates scores.
Analyze the report: In addition to the SEO score, the score checker will
likely provide a report detailing various on-page and off-page factors
that are impacting the website’s performance. Read through this report
carefully and make note of any areas where the website can improve.
Implement recommended changes: Based on the report, implement any
changes that are recommended by the score checker. This might
include optimizing title tags, meta descriptions, and header tags,
improving content quality, or building more high-quality backlinks.
Repeat the process: Once you’ve made the recommended changes, re-
run the analysis in a few weeks to see how your SEO score has changed.
Continuously monitor and improve your website’s SEO performance to
stay ahead of your competition.
>
By following these steps, you should have a good understanding of your
website’s SEO score and what you can do to improve it. Remember that
SEO is an ongoing process, so be prepared to continuously monitor and
improve your website’s performance.
>
### SEO Factors
Many factors can impact a website’s search engine optimization (SEO)



performance, and they can be broadly categorized into on-page factors
and off-page factors.

® On-page factors refer to elements that are within a website’s control
and include:

o Content quality and relevance: The quality and relevance of the
website’s content for its target audience.

o Keyword usage: The strategic use of keywords (target search terms)
in titles, meta descriptions, header tags, and throughout the
website’s content.

o User experience: The overall user experience of the website,
including website speed, mobile responsiveness, and ease of
navigation.

o Meta tags: The use of title tags and meta descriptions to accurately
describe the website’s content and entice users to click through
from the search results.

e Off-page factors refer to elements that are outside of a website’s control
and include:

o Backlinks: The quantity and quality of links from other websites to
the website in question.

o Social signals: The presence and activity of the website on social
media platforms.

o Domain authority: The overall authority and credibility of the
website’s domain.

o Brand reputation: The overall reputation of the website’s brand.
>
These are some of the most important SEO factors, but it’s worth
noting that search engines like Google are constantly updating their
algorithms and what they consider to be important, so it’s important
to stay up-to-date on best practices for SEO. Here’s one of the best
resources to stay up to date: https://www.searchenginejournal.com/.



Importance of SEO Score Checker

Importance of SEO Score Checker

SEO score checkers are an important tool for website owners and
marketers because they provide valuable insights into the website’s search
engine optimization (SEO) performance. Here are some of the reasons why
SEO score checkers are important:

- Identifying areas for improvement: SEO score checkers provide a
comprehensive analysis of the website’s on-page and off-page factors,
including keyword usage, content quality, backlinks, and user experience.
This information can help website owners identify areas where they can
make improvements to boost their SEO performance.

>

- Measuring progress: SEO is an ongoing process, and website owners
need to continuously monitor and improve their performance to stay
ahead of the competition. SEO score checkers allow website owners to track
their progress over time, see how changes to their website have affected
their SEO score, and adjust their strategy accordingly.

>

- Comparing performance to competitors: Many SEO score checkers also
provide competitor analysis, allowing website owners to compare their
performance to that of their competitors. This information can help



website owners understand how they stack up against their competition
and identify opportunities for improvement.

>

- Making data-driven decisions: SEO can be complex, and it can be
difficult to know where to focus your efforts. SEO score checkers provide a
comprehensive analysis of the website’s performance, allowing website
owners to make data-driven decisions about where to focus their efforts for
maximum impact. Here’s an example for Amazon from the Moz tool that

you can try yourself: https://moz.com/competitive-research
>

amazon.ca Analyze domain

Domain Authority Page Authority Ranking Keywords

Top Positions

92 70 283.6k Loy

Top Competitors Keyword Opportunities

Learn who your top SERP competitors are, powered by our True Spot your keyword gaps by understanding your competitors’ top

Competitor engine. keywords and the potential impact on site traffic.
Competitors DA Keyword Traffic Lift
wwwyoutube.com 100 amazon prime video in 429,473
www.amazon.com 96 amazon+prime video 429473
www.facebook.com 96 amazon prime video 386,643
www.pinterest.com 94 prime video 382,321
books.google.com 93 alabama football 266,791

See more competitors See more keywords

- Streamlining the optimization process: Finally, SEO score checkers can
help streamline the optimization process by providing step-by-step
instructions for implementing recommended changes. This can save
website owners time and effort and help ensure that they are making the
right changes to boost their SEO performance. Here’s an example from
GTMetrix for amazon.ca

>

Top Issues

FCP LCP TBT CLS  Theseaudis are identified as the top issues impacting your performance.

Avoid an excessive DOM size T8T 3,060 elements o Focus on these audits first
These audits likely have the largest
Alarge DOM will increase memory usage, cause longer style calculations, and produce costly layout reflows. Leam how to improve this. impact on your page performance.

Structure audits do not directly
affect your Performance Score, but
improving the audits seen here can

Total DOM Elements 2060 help as a starting point for overall
performance gains.

See all Structure audits

Maximum DOM Depth i L . : 2

Skip to main content .ca Hello Select your address Al All Departments Alexa Sk
<div id="a-page">

Maximum Child Elements

Avoid unload event listeners 1 listener found v
Use a Content Delivery Network (CDN) 68 resources found v
Avoid enormous network payloads LCP Total size was 3.40MB v
Avoid long main-thread tasks T8T 8long tasks found v

>

### How to Use an SEO Score Checker

Using an SEO Score Checker is simple and straightforward. Simply enter
the URL of the website that you want to check into the tool, and the tool will



analyze various factors related to the website’s SEO and provide a score.
Some SEO Score Checkers also provide additional information and
suggestions for improvement.

>

One popular SEO checker is SEODbility (
https://www.seobility.net/en/seocheck/ ).

>

Exercise: Pick one of your favorite websites and input the URL in the
SEODility box. List 3 SEO improvements your selected website should make.

Free SEO Checker

Test your Website with the SEO
Checker from Seobility!

Compliance with search engine guidelines is an important factor for

the success of your website. The SEO Checker analyzes your website

and gives you tips on optimizing your site for a long-term success in
search engine optimization!

https://apple.com/ UL A

You have 1 of 3 checks left today.
More options
We will use https://apple.com/ for this example.
>
Here is a screenshot of SEObility’s site audit feature, which analyzes

various on-page SEO elements and provides recommendations for
improvement:

Analyze your website with Seobility: https://www.apple.com/ m
You have 1 of 3 checks left today.
Apple'com - SEO Checker I [ PDF Export © sign up for free!
Overview of the SEO Check SEO Score

«

tinkstructure TR
()
R server 75%
SEO Score Widget
© Response time P File size T Words Cd Media files & Number of links
0.05s 157.80 kB 537 1 98 internal / 11 external

>

SEO score checkers like SEODbility typically provide a variety of information
and suggestions for improvement, including:

>

- Website Crawling and Indexing: Seobility checks if a website is
crawlable and indexable by search engines like Google and provides

suggestions to improve the website’s crawlability and indexability.
>



- On-Page Optimization: Seobility analyzes the content of a website and
provides suggestions for optimizing the page title, meta description,
heading tags, and other on-page elements for better visibility in search
engine results.

>

- Technical SEO: Seobility checks technical SEO aspects such as website
speed, mobile-friendliness, and schema markup, and provides suggestions
to improve these aspects for better SEO performance.

>

- Backlink Analysis (A backlink is a hyperlink from one website to
another, typically using an anchor text): Seobility analyzes the backlink
profile of a website and provides suggestions for improving the quality and
quantity of backlinks to the website.

>

- Keyword Analysis: Seobility analyzes the keywords used on a website
and provides suggestions for optimizing the content for relevant and high-
traffic keywords.

>

In addition to providing this information, SEO checkers often include step-
by-step instructions for implementing recommended changes, making it
easier for website owners to improve their search engine optimization.

>

In general, SEO checkers analyze various elements of a website to assess its
performance in search engines. These elements may include on-page
factors like title tags, meta descriptions, header tags, and content quality, as
well as off-page factors like backlinks and social media signals. The goal is
to identify any issues that could be hurting the site’s visibility in search
results and provide recommendations for improvement.



Generating a Report of
Recommendations

Generating a Report of Recommendations

Generating a report of recommendations for an SEO Score Checker is an
important step in improving the SEO performance of a website. A well-
written report provides actionable recommendations that help website
owners improve their SEO and increase their website’s visibility in search
results.

### Components of a Report

A good SEO Score Checker report should include the following components:
Executive Summary: A brief overview of the report and its findings.
Current SEO Score: A detailed analysis of the website’s current SEO score,
including the specific factors that contributed to the score.
Recommendations for Improvement: A list of specific recommendations
for improving the website’s SEQ, such as optimizing keywords, improving
page titles, and increasing the number of backlinks.

Next Steps: A list of actionable steps that the website owner can take to
implement the recommendations and improve their SEO.

>

### Implementing Recommendations

Once the report has been generated, the next step is to implement the
recommendations. This may involve making changes to the website’s
content, structure, and technical aspects.

>

The report should provide clear and concise instructions for implementing
each recommendation, and website owners should take the time to
carefully review the recommendations and make the necessary changes.

>

Implementing the recommendations from an SEO score checker report is a
critical step in improving a website’s search engine optimization (SEO)
performance. Here are some best practices for implementing the
recommendations:

- Prioritize recommendations: Not all recommendations will have an equal
impact, so it’s important to prioritize the recommendations based on their
potential impact and the effort required to implement them.

- Create a plan of action: Once you have prioritized the recommendations,
create a plan of action that outlines the steps you need to take to implement
each one.

- Make changes gradually: Avoid making too many changes at once, as this
can cause confusion and negatively impact the website’s performance.
Instead, make changes gradually, test them, and adjust as necessary.



- Monitor the impact of changes: As you implement the recommendations,
monitor the impact of the changes on the website’s performance. Use
analytics tools and other metrics to track the website’s traffic, search engine
rankings, and other important metrics.

- Stay up-to-date with best practices: SEO is an ever-evolving field, and best
practices are constantly changing. Stay up-to-date with the latest
developments in SEO by reading industry blogs, attending conferences, and
participating in online forums.

>

By following these best practices, website owners can implement the
recommendations from an SEO score checker report effectively and
efficiently. This will help improve their website’s SEO performance, drive
traffic, and increase conversions.

>

Here are some resources for you to run a check on your own website and
implement one suggestion:

- Google Pagespeed Insights: https://pagespeed.web.dev/

- GTMetrix: https://gtmetrix.com/

- SEODility: https://www.seobility.net/en/seocheck/

- SEO Site Checkup: https://seositecheckup.com/

- Neil Patels’ SEO Analyzer: https://neilpatel.com/seo-analyzer/



Mobile vs. Desktop Reports

Mobile vs. Desktop Reports

al

### Introduction

In today’s digital age, it’s important to understand the differences between
mobile and desktop SEO as more and more people are using mobile devices
to access the internet. An SEO Score Checker can generate reports
specifically for mobile and desktop devices to help website owners
understand how their site is performing on each platform.

>

### Differences between Mobile and Desktop Reports

The main difference between mobile and desktop reports is that the former
focuses on optimizing the website for small screens and touch-based
navigation, while the latter focuses on optimizing for larger screens and
keyboard-based navigation. This means that the recommendations for
improving mobile and desktop SEO will differ, even though some of the
underlying principles may be the same. You can run your own report here:
https://pagespeed.web.dev/ and toggle between mobile and desktops to see

the difference. Here’s a screenshot:
>



https://amazon.ca/

l

D Mobile [ Desktop

Showing results for URL: https://www.amazon.ca/

Run with original URL

Discover what your real users are experiencing

Largest Contentful Paint (LCP)

11s
s

OTHER NOTABLE METRICS

First Contentful Paint (FCP),

1s
S

) Latest 28-day collection period

@ Full visit durations

Core Web Vitals Assessment: Passed @

First Input Delay_(FID)

Interaction to Next Paint (INP) &
154 ms
f

LT Various mobile devices

" Various network connections

This URL  Origin

Expand view

Cumulative Layout Shift (CLS)

0O

Time to First Byte (TTEB) &
06s
A

& Many samples (Chrome UX Report)

@ All Chrome versions

| Mobile Reports | Desktop Reports |

| ————I

| Focus on small screens and touch-based navigation | Focus on larger
screens and keyboard-based navigation |

| Recommendations tailored for optimizing small

screens | Recommendations tailored for optimizing larger screens|

| Emphasis on mobile-friendly design and user experience | Emphasis on
traditional desktop user experience |

| Aimed at improving the visibility of websites on mobile devices | Aimed at
improving the visibility of websites on desktop devices |

>

### Importance of Mobile Reports

Mobile devices have rapidly become the preferred method for accessing
the internet, and this trend is only expected to continue in the future. As a
result, it’s critical for website owners to ensure that their website is
optimized for mobile devices. Here are some of the reasons why mobile
reports are important:

>

- Improving user experience: A well-optimized mobile website provides
users with a fast, responsive, and easy-to-use experience. This can improve
user engagement, reduce bounce rates, and increase the likelihood of users
returning to the site.

>

- Improving visibility in mobile search results: Google and other search
engines prioritize mobile-friendly websites in their mobile search results. A
mobile-optimized website is more likely to rank well in mobile search
results, which can drive more traffic to the site and increase conversions.

>

- Improving mobile accessibility: Mobile reports help website owners
identify any technical issues that may be affecting the site’s performance



on mobile devices. This can include issues with the website’s code, design,
and functionality. Fixing these issues can improve the site’s mobile
accessibility and provide users with a better experience.

>

- Staying ahead of the competition: With the increasing importance of
mobile optimization, it’s critical for website owners to stay ahead of their
competition. Mobile reports provide valuable insights into the site’s mobile
performance and can help website owners identify areas for improvement
and make the necessary changes.

>

In conclusion, mobile reports are an essential tool for website owners
looking to improve their mobile SEO performance. By providing valuable
insights into the site’s mobile performance, mobile reports can help website
owners improve their site’s user experience, visibility in mobile search
results, and overall performance.

>

### Importance of Desktop Reports

Although mobile devices are becoming increasingly popular, many people
still use desktop computers to access the internet. Therefore, it’s important
to have a well-optimized desktop website as well. A good desktop SEO
report can help website owners understand how their site is performing on
desktop devices and provide recommendations for improvement. Here are
some of the reasons why desktop reports are important:

>

- Reach a wider audience: Not everyone uses mobile devices to access the
internet. Many people still prefer desktop computers, and it’s important to
cater to this audience by having a well-optimized desktop website.

>

- Improved search engine rankings: A well-optimized desktop website is
more likely to rank well in desktop search results, which can drive more
traffic to the site and increase conversions.

>

- Better user experience: A good desktop website provides users with a
fast, responsive, and easy-to-use experience. This can improve user
engagement, reduce bounce rates, and increase the likelihood of users
returning to the site.

>

- In-depth insights: Desktop reports provide in-depth insights into the site’s
desktop performance, including its load times, technical issues, and user
behavior. This information can help website owners identify areas for
improvement and make the necessary changes to improve their site’s
performance.

>

- Improved accessibility: Desktop reports help website owners identify
any technical issues that may be affecting the site’s performance on
desktop devices. This can include issues with the website’s code, design,
and functionality. Fixing these issues can improve the site’s desktop
accessibility and provide users with a better experience.



>

In conclusion, desktop reports are still an important tool for website
owners looking to improve their desktop SEO performance. By providing
valuable insights into the site’s desktop performance, desktop reports can
help website owners understand how their site is performing and provide
recommendations for improvement.



Conclusion & Takeaways

Conclusion & Takeaways

SEO score checkers provide valuable insights into the overall health and
optimization of a website, allowing website owners to identify areas for
improvement. Regularly checking and monitoring the SEO score of a
website is an important aspect of search engine optimization and can lead
to improved visibility and ranking in search engine results.

>
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Robots.txt Generators, Hit Counter and A/B Testing
Robots.txt Generator

Goals:

e Understand the purpose of robots.txt file: control web crawlers and
search engine bhots

e C(Create basic robots.txt file to restrict website access

e Learn syntax and commands for writing robots.txt file: User-Agent,
Disallow rules

e Structure and organize robots.txt files for proper interpretation

e Connect robots.txt files to optimizing websites for search engines:
improve web dev and SEO knowledge
>
### Introduction
The robots.txt file is an important aspect of website optimization. It
provides information to search engine robots about which pages or
sections of the site should be crawled and indexed. By using a Robots.txt
Generator, you can quickly and easily create a robots.txt file for your
website. You can generate your own Robots.txt file here:
https://en.ryte.com/free-tools/robots-txt-generator/



What is a Robots.txt File?

What is a Robots.txt File?

©©

A robots.txt file is a simple text file that is placed in the root directory of a
website which is the public_html folder. It tells search engine robots which
pages or sections of the site they should crawl and index. This can be useful
if you have certain pages or sections of your site that you don’t want to be
indexed by search engines.

>

The robots.txt file is essentially a set of instructions for search engine
robots (also known as crawlers or spiders) that visit your website. By
including a robots.txt file, website owners can control which pages or
sections of their site are crawled and indexed by search engines.

>

The file consists of simple text commands that specify which parts of the
site should be crawled, and which should be excluded. For example, if a
website owner wants to exclude a certain directory, such as a staging
environment or a private area of the site, they can do so by adding the
following line to their robots.txt file:

>

User-agent:

Disallow: /admin/

Disallow: /private/

Disallow: /secret-page.html
>



This robots.txt file instructs all web crawlers (User-agent: ) not to index the
pages in the /admin/, /private/ and /secret-page.html directories. This can be
useful for preventing sensitive pages or pages that are not relevant to
search engine indexing from being crawled and indexed.

>

It’s important to note that while the robots.txt file can be used to limit the
visibility of a website in search results, it is not a foolproof method for
hiding content. Determined users or search engines can still access
excluded pages if they have a direct link or know the URL.

>

Here are a few examples of how the robots.txt file can be used:

- Excluding a directory:

User-agent:

Disallow: /private/

>

This line tells all search engines not to crawl or index the “private” directory
on the website.

- Excluding a specific page:

User-agent:

Disallow: /page-to-exclude.html

>

This line tells all search engines not to crawl or index the specific page
“page-to-exclude.html.”

- Allowing all pages to be crawled:

User-agent:

Disallow:

>

This line allows all search engines to crawl and index all pages on the
website.

- Blocking specific search engines:

User-agent: Googlebot

Disallow: /

>

This line blocks Googlebot from crawling or indexing any pages on the
website.

>

These are just a few examples of the many ways that the robots.txt file can be
used to control which pages on a website are crawled and indexed by search
engines. It’s important to note that not all search engines and robots follow
the instructions specified in the robots.txt file, so it’s not a foolproof method
for hiding content. However, it is still a useful tool for website owners to have
in their SEO toolkit.

>

Exercise 1:

>

Write a robots.txt file for a website that has a “blog” section that you want to

be excluded from search engine indexing.
>



Instructions:

>

1. Imagine you are the owner of a website that has a “blog” section.

2. Write a robots.txt file using the format described in the content.

3. Use the robots.txt file to exclude the “blog” section from search engine
indexing.

4. Test the robots.txt file to make sure it is working correctly. Here’s how to
test it:

a. Go to this site: https://technicalseo.com/tools/robots-txt/

b. Type in your website URL you want to test, choose any user agent
(Googlebot) is a good one, leave it to live, tick check resources and click ‘Test’

alidate your robots.xt with this testing tool. Check if a URL is blocked, which statement is blocking it and for which user agent. You can also check if the resources for the page (CSS, JavaScript, images) are

@ tve O Edior [ checkResources

You will get results showing any URLs you have disallowed and the result of
your robots.txt file. Here’s an example of https://amazon.ca

https://amazon.ca Googlebot - Q tve @ Editor Check Resources TEST

User.

D:

ndle-buy-box

/em/member /

frie

D:
D:
D.
D,
D.
D.
D:
D:
D:
D:
D.
D:
D,
D:
D:
D

.
D:
D:

robots.txt: https://www.amazon.ca/robots.txt (200 OK) URL Path: Result:

Answer:

Robots.txt file:

>

User-agent:

Disallow: /blog/

>

Explanation: This robots.txt file instructs all search engines (User-agent: *)
not to index the pages in the /blog/ directory.

>

Testing: To test this robots.txt file, you can use a robots.txt tester tool (such
as Google’s robots.txt tester) to see if the “blog” section is being excluded
from search engine indexing.



Best Practices for Robots.txt Files

Best Practices for Robots.txt Files

Best practices for robots.txt files are essential for ensuring that the file is
effective and that search engines can access it. Here are some of the best
practices in detail:

>

- Ensuring that the file is accessible to search engines: The robots.txt file
should be placed in the root directory of the website and should be easily
accessible to search engines. This can be done by ensuring that the file is
located at the root URL (e.g. https://www.example.com/robots.txt).

>

This is important because if the file is not easily accessible to search
engines, they may not be able to find it and therefore, the instructions in
the file will not be followed. Having the file accessible in the root directory
ensures that search engines can quickly and easily find the file, allowing
them to follow the instructions contained within it. This can help prevent
search engines from crawling and indexing pages that are not meant to be
indexed, improving the overall SEO of the website.

>

- Using clear and concise instructions: The robots.txt file should use clear
and concise commands to specify which pages or sections of the site should
be crawled and indexed. For example, the file should use a disallow
statement to specify the pages that should not be crawled and indexed.

>

Using clear and concise instructions helps search engines understand
exactly what is allowed and what is prohibited on the site. This ensures
that search engines only crawl and index the desired pages, reducing the
risk of any unwanted pages appearing in search results.

>

- Avoiding the use of wildcard characters: Wildcard characters (e.g. * or
)shouldbeavoidedinrobots.txt files. T hisisbecausetheycanleadtounintendedconsequencesandcanmakethe
Avoidingtheuseo fwildcardcharactersisimportantbecausesearchenginesmayinterpretthewildcardchara
Wildcards : Use” *

”torepresentanysequenceofcharacters, andendpatternswith”" to
signify the end of a name.

>

For instance:

>

To block access to every URL containing a question mark “?”:

User-agent:

Disallow: /?

>

The “$” symbol is employed for “end of URL” matches. In this example,
GoogleBot is prevented from crawling URLs ending with “.php”:
User-agent: Googlebot

Disallow: /.php$

>

To exclude all files of a specific file type, apply the following:

User-agent: Googlebot-Image

Disallow: /.gif$

>

By designating Googlebot-Image as the User-agent, images will be omitted
from Google Image Search.

>

- Avoiding the use of disallow statements: Disallow statements should be
used with caution. If possible, allow statements should be used instead.
This is because disallow statements can prevent search engines from
accessing important pages on the site, which can negatively impact its SEO.
>

The use of disallow statements in the robots.txt file tells search engines not
to crawl and index certain pages or sections of the website. However, if
these disallow statements are not used carefully, they can prevent search
engines from accessing important pages on the site. This can negatively
impact the site’s SEO by preventing search engines from discovering and
indexing all of the site’s content.

>

For instance, consider an online store that has a blog section and a private
customer account section. The website owner wants search engines to
crawl and index the blog but not the customer account section. If the
disallow statement is not used carefully, it may block search engines from
accessing both the blog and the customer account sections. This would



negatively affect the website’s SEO by preventing search engines from
indexing the blog’s content.

>

Here’s an example of a properly configured robots.txt file:

>

User-agent: *
Disallow: /customer-account/
Allow: /blog/

By following these best practices, website owners can ensure that their
robots.txt file is effective and that search engines can access it. This can
help improve the visibility of the site in search results and provide a better
experience for users.



Hit Counter

Hit Counter

Goals:

Understand website hit tracking and its importance

Learn to implement a hit counter using HTML/JS/programming
language

Integrate and display hit counter results on websites

Customize hit counter appearance and functionality for website needs
Enhance web dev and data analysis skills by tracking website traffic for
informed decisions

>

### What is a Hit Counter?

A hit counter is a tool used by website owners to track the number of
visits or hits to their website. It is often displayed as a graphical
representation of the number of visits, and it provides valuable
information to website owners about the popularity and usage of their
website.

>

### How a Hit Counter Works:

A hit counter works by counting the number of times a page on a
website is accessed. When a user visits a page on the website, the hit
counter code sends a request to a server, which increments the counter
by one. This information is then displayed on the website as a hit
counter.

>

### Why Use a Hit Counter:

Hit counters are useful for website owners for several reasons. Firstly,
they provide a way to track the number of visitors to the site, which



helps the website owner understand the popularity of their website and
make decisions about how to improve it.

>

Secondly, hit counters can be used to track the success of different
marketing campaigns by measuring the number of visitors to the site
before and after the campaign.

>

Finally, hit counters provide a way to monitor the performance of
different pages on a website, by measuring the number of visits to each
page.

>

In conclusion, a hit counter is a useful tool for website owners to track
the popularity and usage of their website. By understanding the
number of visits and the performance of different pages, website
owners can make informed decisions to improve their websites and
attract more visitors.

>

Examples:

Simple Text Hit Counter: This type of hit counter displays the number
of visitors in a simple text format. This can be implemented using basic
HTML and JavaScript.

>

Image-based Hit Counter: This type of hit counter uses a small image
to display the number of visitors. This can be implemented using basic
HTML, JavaScript and PHP.

>

Graphical Hit Counter: This type of hit counter displays the number of
visitors in a graphical format, such as a bar or pie chart. This can be
implemented using JavaScript and PHP.

>

Animated Hit Counter: This type of hit counter animates the numbers
as they change, to show the number of visitors. This can be
implemented using JavaScript and PHP.

>

Log File Hit Counter: This type of hit counter uses a log file to store
information about the number of visitors to the website. The
information can then be displayed in various formats, such as a simple
text or graphical display.

>

Example of a hit counter in JavaScript:

>

A simple hit counter in HTML and JavaScript that utilizes a free third-
party API is a more suitable example for a real-world use case. This
example uses the “CountAPI” (https://countapi.xyz/) service to create
and maintain the hit counter.

>

1. Create an index.html file and paste the following code:



<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-
scale=1.0">
<title>Hit Counter Example</title>
<script>
async function updateHitCounter() {
const namespace = 'example-website'; // Replace with your
desired namespace
const key = 'homepage'; // Replace with your desired key
const response = await
fetch( https://api.countapi.xyz/hit/${namespace}/${key}");
const data = await response.json();
document.getElementById("hitCountexr").innexHTML =
data.value;
}
</script>
</head>
<body onload="updateHitCountex()">
<h1>Hit Counter Using CountAPI</h1l>
<p>This page has been visited <span id="hitCounter">0</span>
times.</p>
</body>
</html>

In this example, replace your-namespace and your-key with custom
values that uniquely identify your hit counter. The updateHitCounter
function fetches the current hit count from CountAPI, increments it, and
updates the hitCounter span element with the new count.

>

2. Open the index.html file in your web browser, and you’ll see the hit
counter increment each time you refresh the page.

>

This hit counter utilizes a third-party service to store and manage the hit
count, making it suitable for real-world usage. However, if you require
more control and scalability, consider implementing server-side tracking or
using a more comprehensive analytics service like Google Analytics.



A/B Testing

A/B Testing

Goals:

Understand the purpose of A/B testing in website optimization and
digital product improvement.

Learn to design and conduct basic A/B tests.

Use A/B testing tools and techniques to collect and analyze data.
Make informed decisions based on A/B test results.

Enhance skills in web development, UX design, and data analysis
through A/B testing.

A/B testing is a method of comparing two versions of a website or a
marketing campaign to determine which one performs better. This
process involves randomly dividing website visitors or target audiences
into two groups. The first group is shown the original version of the
website or campaign (referred to as “A”), while the second group is
shown a variation of it (referred to as “B”). By measuring the
conversion rate and other key performance indicators of each group,
businesses can determine which version of the website or campaign is



more effective.

>

A/B testing is a crucial component of modern digital marketing and
website optimization. By comparing two variations of a website or
campaign, businesses can gain valuable insights into what resonates
with their audience and what doesn’t. This information can then be
used to make informed decisions about the design and content of their
website or campaign, leading to more effective results.

>

A/B testing can be applied to a variety of different elements, including
website layout, color scheme, headlines, images, call-to-action buttons,
and more. By testing different combinations of these elements,
businesses can find the combination that provides the best results for
their specific audience.

>

It’s important to note that A/B testing should be an ongoing process, not
a one-time event. As customer preferences change and new
technologies emerge, businesses must continually adapt and test their
online presence to ensure they’re providing the best possible
experience for their audience.

>

In conclusion, A/B testing is a valuable tool for businesses looking to
optimize their online presence and drive more revenue. By continually
testing and optimizing different elements of their website or marketing
campaign, businesses can make data-driven decisions that lead to
improved results and a better user experience.

>

Example use case scenario 1:

A clothing retailer wants to increase the conversion rate on its product
detail page (PDP). The retailer creates two versions of the PDP: Version
A, the original version, and Version B, which includes product reviews
and testimonials.

>

The retailer uses A/B testing to randomly divide website visitors into
two groups. Group A sees Version A of the PDP, while Group B sees
Version B of the PDP. Over the next two weeks, the retailer tracks the
conversion rate of each group.

>

At the end of the two weeks, the retailer discovers that Group B had a
higher conversion rate compared to Group A. The retailer then
concludes that the addition of product reviews and social proof on the
PDP has a positive impact on the conversion rate.

>

Based on this data, the retailer decides to implement Version B of the
PDP for all visitors. The retailer can then continue to run A/B tests on
different elements of the PDP to further optimize its conversion rate.

>

This example demonstrates how A/B testing can be used to make data-



driven decisions about the design and content of a website. By testing
and optimizing different elements, businesses can continuously
improve their online presence and drive more revenue.

>

Example use case scenario 2:

A financial services company wants to increase the click-through rate
on its email marketing campaigns. The company creates two versions of
its email marketing campaign: Version A, the original version, and
Version B, which includes a personalized subject line and a different
call-to-action.

>

The company uses A/B testing to randomly divide its email subscribers
into two groups. Group A receives Version A of the email marketing
campaign, while Group B receives Version B of the email marketing
campaign. Over the next week, the company tracks the click-through
rate of each group.

>

At the end of the week, the company discovers that Group B had a
higher click-through rate compared to Group A. The company then
concludes that the personalized subject line and the different call-to-
action in Version B had a positive impact on the click-through rate.

>

Based on this data, the company decides to implement Version B for all
future email marketing campaigns. The company can then continue to
run A/B tests on different elements of its email marketing campaigns,
such as the subject line, the call-to-action, and the email content, to
further optimize its click-through rate.

>

This example demonstrates how A/B testing can be used to make data-
driven decisions about the content and design of email marketing
campaigns. By testing and optimizing different elements, businesses
can improve their email marketing performance and drive more
revenue.



Tools available for A/B Testing:

Tools available for A/B Testing:

® Google Optimize: A free A/B testing tool offered by Google that allows
businesses to test different versions of their website to see which one
performs better. As an exercise, you can go here follow the instructions
and set up your own website A/B test:
https://support.google.com/optimize/answer/6211930?hl=en
>
e Optimizely: A popular A/B testing and website optimization platform
that offers a range of testing and personalization capabilities.
>
® VWO: A cloud-based website optimization platform that allows
businesses to perform A/B tests, split tests, and multivariate tests on
their websites.
>
e Unbounce: A landing page optimization platform that offers A/B testing
and personalization capabilities.
>
e Convert: An A/B testing and optimization platform that helps
businesses improve their website’s performance and conversion rates.
>
e Adobe Target: An enterprise-level A/B testing and personalization
platform that integrates with Adobe Experience Cloud.
>
e Crazy Egg: A heat mapping and A/B testing tool that helps businesses
understand how visitors interact with their website.
>
These are just a few of the many A/B testing tools available. The right
tool for a particular business will depend on its specific needs, budget,
and level of technical expertise.
>
### Why A/B Testing is Important:
A/B testing is an important tool for businesses looking to optimize their
online presence and drive better results. In this section, we will discuss
the key benefits of A/B testing and why businesses need to implement it.
>
e Improving Conversion Rates
o A/B testing can help businesses improve conversion rates by
identifying which elements of a website or marketing campaign
have the greatest impact and make improvements accordingly.
>

¢ Enhancing User Experience



o A/B testing can help businesses improve user experience by
understanding what their audience responds to, creating higher
engagement and customer satisfaction.
>

¢ Driving Revenue

o A/B testing can drive revenue by improving conversion rates,
enhancing user experience, and generating more leads and sales,
resulting in financial success and goal achievement for businesses.
>

e Reducing Risk
A/B testing reduces the risk of negative changes to a business’s website
or marketing campaign by testing changes before making them
permanent, ensuring any changes have a positive impact and avoiding
costly mistakes.
>
In conclusion, A/B testing is an important tool for businesses looking to
optimize their online presence and drive better results. By testing
different elements of their website or marketing campaign, businesses
can improve conversion rates, enhance the user experience, drive more
revenue, and reduce the risk of negative changes. As a result, A/B
testing is an essential tool for any business looking to succeed in the
digital landscape.



Conclusion & Takeaways

Conclusion & Takeaways

In conclusion, understanding SEO score checker tools can help improve a
website’s visibility in search engine results, while properly implementing a
robots.txt file can prevent search engine crawlers from indexing certain
pages. A/B testing can also provide valuable insights into the effectiveness
of different website elements and inform decisions for optimizing user
experience and conversion rates.

>
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Website Performance

Website Performance

Goals

By the end of this case you will:

- Understand the various factors that impact website performance,
including load time, the number of scripts and stylesheets, image
optimization, and caching.

- Become proficient in using tools such as Pagespeed Insights and
Lighthouse to analyze website performance and identify performance
bottlenecks.

- Learn how to generate a report of recommendations, prioritize
improvement actions based on their potential impact, and optimize website
performance for both mobile and desktop devices.

>
### Introduction

L
LT

Website performance is an essential aspect of modern websites, as it
directly impacts the user experience and search engine optimization. A



slow website can lead to a high bounce rate, lower conversion rates, and
reduced search engine rankings. In this lesson, we will cover the various
factors that impact website performance and how to optimize them.



Load Time

Load Time

The load time of a website is a critical factor in the overall user experience.
A website that takes too long to load can lead to a high bounce rate, lower
conversion rates, and reduced search engine rankings.

>

The load time of a website is the time it takes for a page to fully load in a
user’s browser. The size of the website, the number of images, videos, and
other multimedia content, and the number of scripts and stylesheets all
play a role in determining load time. To improve the load time of your
website, it’s important to consider these factors.

>

### Factors that Impact Load Time:

The load time of a website is influenced by several factors, including:

- Size of the website: The larger the website, the longer it takes to load.

- Number of images, videos, and other multimedia content: These types
of content are typically larger in size and can slow down the load time.

- Number of scripts and stylesheets: Scripts and stylesheets are an
essential part of website functionality, but they can also slow down the load
time.

>

### Examples of Load Time Impact:

Here are a few examples of how load time can impact a website:

e User Experience: A slow-loading website can frustrate users and lead
to a high bounce rate. Users are more likely to abandon a website if it
takes too long to load.

e Search Engine Optimization: Search engines like Google consider load
time as a ranking factor. A slow website can result in a lower search
engine ranking, which can impact visibility and traffic.

e Conversion Rates: A slow website can also reduce conversion rates, as
users are less likely to complete a purchase or sign up for a service if
the website takes too long to load.

>

Case 1: Question: Large Website Size



Async and Defer Scripts

Async and Defer Scripts

Async and Defer are attributes that can be added to the script tag to control
how and when the script is loaded. They are used to manage the loading
and execution of external scripts in order to optimize the performance of a
website.

### Async Scripts

Async: Scripts marked with the async attribute means a script loads in the
background and doesn’t block the page from rendering. The script runs as
soon as it’s finished downloading. Once the script has finished
downloading, it is executed immediately. This is useful for scripts that do
not need to be executed as soon as the page loads and do not depend on the
completion of other scripts. This helps improve page load speed and allows
multiple scripts to run independently.

>

Here’s an example of how that looks:

>

<script async src="example.js"></script>

>

In this example, the script file “example.js” is loaded in the background,
allowing the rest of the page to continue loading while the script is
downloading. Once the script has finished downloading, it will be executed
immediately.

>

### Defer Scripts

Scripts marked with the defer attribute are loaded and executed in the
order they appear in the HTML, after the page has finished loading. This is
useful for scripts that need to be executed in a specific order or are
dependent on the completion of other scripts.

>

Here’s an example of how that looks:
>

<script defer src="examplel.js"></script>
<script defer src="example2.js"></script>



In this example, both script files “examplel.js” and “example2.js” are
loaded using the defer attribute. The browser will wait until the page
has finished loading before executing the scripts. The scripts will be
executed in the order they appear in the HTML, so in this case
“examplel.js” will be executed first and then “example2.js”. This is
useful if the scripts are dependent on each other or need to be
executed in a specific order.

Exercise: Case Study

You have a webpage with multiple external scripts. Your goal is to
optimize the performance of the webpage. You have three external
scripts:

1. “Ajs”

1. “B.js”

1. “C.js”

Here is the scenario:

- “A.js” is not dependent on any other scripts and does not need to be
executed immediately when the page loads.

- “B.js” needs to be executed in a specific order and depends on the
completion of “A.js”.

- “C.js” does not need to be executed immediately when the page
loads and does not depend on any other scripts.

1. Decide which of the scripts should use the “async” attribute and
which should use the “defer” attribute. Then write the script tags
for each of the external scripts, using either “async” or “defer” as
appropriate. (eg. <script async src="etc.js></script>)

2. Explain why you chose to use either “async” or “defer” for each
script.

Answer:
1. The script tags for each of the external scripts:

<script async src="A.js"></script>
<script defer src="B.js"></script>
<script async src="C.js"></script>

2. “A.js” was given the “async” attribute because it does not need to
be executed immediately when the page loads and does not
depend on any other scripts.

“B.js” was given the “defer” attribute because it needs to be
executed in a specific order and depends on the completion of
“A.js”.

“C.js” was given the “async” attribute because it does not need to
be executed immediately when the page loads and does not
depend on any other scripts.



Serialization

Serialization

Serialization is the process of converting structured data, such as objects or
arrays, into a format that can be stored or transmitted over the internet.
The process of serialization allows data to be represented in a compact,
easy-to-manipulate format that can be efficiently transmitted and stored.

>

One common use case for serialization is transmitting data between a
client (such as a web browser) and a server. By serializing data before
sending it from the server to the client, the amount of data that needs to be
transmitted can be reduced, resulting in faster load times and improved
performance.

>

A good example of understanding serialization is thinking of it like putting
your stuff into a suitcase before you go on a trip. Just like you pack your
clothes, books, and gadgets into the suitcase so they’re ready to go with you,
serialization takes data in your computer and packs it into a format that
can be easily transported to another place, like from your computer to a
server on the internet. The packed data is called a “serialized object.” Just
like you can unpack your suitcase when you reach your destination, a
computer program can “deserialize” the serialized data to get the original
information back.

>

There are several popular serialization formats, including JSON, XML, and
binary formats like BSON or Protocol Buffers.

>

Example of serializing an object to JSON:

let object = {

name: 'John Doe',

age: 30,

address: '123 Main St
b

let serialized = JSON.stringify(object);



Example of deserializing a JSON string back to an object:
let deserialized = JSON.parse(serialized);

Serialization can also be used for storing data on disk or in a
database, for transferring data between different systems or
programming languages, or for transmitting data between different
layers of an application. By using serialization, you can simplify the
process of transmitting and storing complex data structures, which
can improve the overall efficiency and scalability of your
applications.

Minify Options

Minification is a technique used in web development to reduce the
size of JavaScript and CSS files. The process involves removing all
unnecessary characters, such as white spaces, comments, and line
breaks, without changing the functionality of the code. By reducing
the size of these files, the time required to download and parse them
is also reduced, which can lead to a faster loading time for a website.

Minification is an important step in optimizing the performance of a
website, especially for mobile users who may have limited
bandwidth or slow connections. Minified files can also reduce the
amount of data transferred, resulting in cost savings for users on
limited data plans.

Here’s some examples of CSS and Javascript Minifications:
CSS minification:

Before minification:

body {

background-color: white;
font-family: Arial, sans-serif;
font-size: 14px;

After minification
body{background-color:white; font-family:Arial,sans-serif;font-
size:14px;}

Now here’s a Javascript example:




Before minification:
function addTwoNumbers(a, b) {

return a + b;

After minification:
>

function addTwoNumbers(a,b){return a+b;}

>

Minification can be done manually or using tools, such as online minifiers
or build tools like Grunt or Gulp. The process of minifying a file can help
improve the load time and overall performance of a website.



Caching

Caching

Caching is a technique that involves temporarily storing data in a cache, or
a temporary storage area, to speed up the retrieval of that data. This can be
especially useful for web pages and applications, as it can reduce the
amount of data that needs to be transmitted over the network, thus
improving the overall performance of the website.

>

Several different types of caching can be used to improve website
performance:

>

Browser caching: This type of caching involves storing frequently used
resources, such as images and CSS files, in the cache of the user’s web
browser. This means that, when the user visits the same website again,
these resources can be retrieved from the cache instead of being requested
from the server, which can significantly reduce the amount of data
transmitted over the network.

>

Server caching: This type of caching involves storing frequently used data
on the server itself. This can be useful for websites and applications that
have dynamic content that changes frequently, as it can reduce the amount
of processing that needs to be done on the server and speed up the delivery
of content to the user.

>

CDN caching: Content Delivery Networks (CDNs) are networks of servers
located in different locations around the world. They can be used to cache
frequently used resources, such as images and videos, so that they can be
quickly delivered to users regardless of their location.

>

Here’s an example of how caching can be used to improve website
performance:

>

A user visits a website for the first time and requests a page. The server
generates the HTML, CSS, and JavaScript needed to render the page, and
sends it back to the user’s browser. The browser stores a copy of these
resources in its cache so that they can be quickly retrieved the next time
the user visits the same page.

>

When the user visits the same page again, the browser can retrieve the
resources from its cache instead of requesting them from the server. This
can significantly reduce the amount of data that needs to be transmitted
over the network, thus improving the overall performance of the website.



>

Exercise: Configuring optimization plugin for your Wordpress website
>

1. Choose an optimization plugin: There are several optimization plugins
available for WordPress, such as WP Rocket, W3 Total Cache, and
Autoptimize. For this example, we’ll use Autoptimize, which is a popular
and easy-to-use plugin that covers script loading, CSS and JS minification,
and more.

2. Install the plugin: Log in to their WordPress admin dashboard, then
navigate to “Plugins” > “Add New”. Search for “Autoptimize” and click
“Install Now” on the plugin card. After installation, click “Activate”.

>

3. Configure the plugin: Once the plugin is activated, go to “Settings” >
“Autoptimize” to configure the plugin settings. In the Autoptimize settings,
you can enable the following options:

a. HTML Options: Check “Optimize HTML Code” to minify HTML.

b. JavaScript Options: Check “Optimize JavaScript Code” to minify JS files.
To load scripts asynchronously, check “Also aggregate inline JS” and “Force
JavaScript in head”.

c. CSS Options: Check “Optimize CSS Code” to minify CSS files. To load CSS
asynchronously, check “Generate data: URIs for images” and “Inline and
Defer CSS”.

>

4. Enable page caching: Although Autoptimize doesn’t include page
caching by default, you can install an additional plugin to enable this
feature. One popular option is the “Cache Enabler” plugin. To install it, go
to “Plugins” > “Add New” and search for “Cache Enabler”. Click “Install
Now” and then “Activate”. After activation, go to “Settings” > “Cache
Enabler” to configure the caching settings.

>

3. Test the website: After configuring the optimization and caching
plugins, test your personal websites to ensure everything is working
correctly. You can use tools like Google PageSpeed Insights or GTmetrix to
analyze your website’s performance and identify any remaining areas for
improvement.

>

By following these steps, you can optimize their personal websites by
loading scripts asynchronously, minifying CSS and JS files, and enabling
page caching, which will result in improved website performance and a
better user experience.



Conclusion & Takeaways

Conclusion & Takeaways

In conclusion, the load time of a website plays a critical role in determining
user experience, search engine rankings and conversion rates. Several
factors such as website size, number of images, videos, scripts and
stylesheets influence the load time and optimization of these elements can
improve the speed. “Async” and “Defer” attributes can be added to the
script tag to manage the loading and execution of external scripts, which
also improve the performance. These are all important factors to be aware
of to ensure that your website is running smoothly and loading quickly!

>

### Attribution

- (n.d.-c). Digital-marketing-plan-smm-business-online-analytical-interface-
display-advertising-analyst-studying-statistical-data-brand-rating. Freepik.
https://www.freepik.com/free-vector/digital-marketing-plan-smm-business-
online-analytical-interface-display-advertising-analyst-studying-statistical-
data-brand-
rating_11669164.htm#query=website%20performance&position=6&from_vi
ew=search&track=ais
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Image Optimization

Goals

By the end of this case you will:

- Understanding the srcset attribute: The learner should be able to explain
the purpose and use of the srcset attribute in HTML for image optimization.
- Utilizing Tinypng for image compression: The learner should be able to
effectively use Tinypng to reduce the size of images without sacrificing
quality, in order to improve website performance.

- Implementing WebP image format: The learner should be able to identify
the benefits of using WebP image format, implement it in their website, and
compare its performance with other image formats.

>

### Introduction

Image optimization is an important aspect of website development that
plays a significant role in determining the load time and overall user
experience of a website. Large, unoptimized images can slow down the
load time of a website and negatively impact the user experience. In this
lesson, we will discuss the various factors that contribute to image size, the
importance of image optimization, and the various techniques used to
optimize images for the web. By understanding and utilizing these
techniques, you can create a faster, more efficient website that provides a
better user experience for your users.



Image Optimization

Image Optimization

Image optimization is a crucial aspect of website performance, as images
can often be a significant source of slow load times. Here are some of the
ways you can optimize images to improve website performance:

>

srcset attribute: The srcset attribute is a HTML attribute that allows you to
specify different versions of an image for different devices and resolutions.
>

For example, you can provide a smaller version of an image for smaller
screens, and a larger version of the same image for larger screens. This can
help reduce the amount of data that needs to be transmitted, which can
improve load times on devices with high pixel density displays.

>

Here’s an example:

<img srcset=" /wp-content/uploads/test4x.jpg 4x, /wp-
content/uploads/test3x.jpg 3x, /wp-content/uploads/test2x.jpg 2x,

/wp-content/uploads/testlx.jpg 1x " src="/wp-

content/uploads/flamingo-fallback. jpg" >
>

Read more: https://html.com/attributes/img-srcset/#ixzz7u4y6PvNq

OR you could watch this video as well: https://www.youtube.com/watch?
v=SyVKRnusyqM

Tinypng (https://tinypng.com/): Tinypng is a tool that can be used to
compress images without losing quality. This can significantly reduce the
size of images and improve load times. Tinypng uses advanced
compression algorithms to reduce the file size of PNG and JPEG images.

File formats: Consider using WebP, a modern image format that provides
better compression than other image formats such as PNG and JPEG. WebP
images can be up to 25-34% smaller in size than their PNG or JPEG
counterparts, which can significantly reduce load times and improve the
performance of your website.

>

Here are some ways you can convert images to WebP:

>

1. Adobe Photoshop: Photoshop is a widely-used image editing software
that can save images in WebP format. To do this, you need to install the
WebP plugin for Photoshop, available at
https://github.com/webmproject/WebPShop. Once the plugin is installed,
open the JPEG image in Photoshop, then go to “File” > “Save As” or “File” >



“Export” > “Save for Web (Legacy)” and choose “WebP” from the format
dropdown menu. Adjust the quality settings if needed and save the file to
see the size difference.

>

2. GIMP (https://www.gimp.org/): GIMP is a free, open-source alternative to
Photoshop that also supports WebP format. To save an image in WebP
format, open the JPEG image in GIMP, then go to “File” > “Export As”. In the
export dialog, choose “WebP” from the file format dropdown menu, adjust
the quality settings, and save the file.

3. Online Image Converters: For those who prefer not to install software,
there are several online image converters that support WebP format, such
as Squoosh (https://squoosh.app/) and Convertio (https://convertio.co/jpeg-
webp/). Upload the JPEG image to the converter, choose the WebP format,
adjust the quality settings, and download the converted file.

>

Example:
<picture>
<source type = "image/webp" srcset = "image.webp">
<img src = "image.jpg" alt = "image description">
</picture>

By using these techniques and tools, you can optimize images to reduce
their size and improve the performance of your website. This can result in
a faster, more enjoyable experience for your users.
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Conclusion & Takeaways

In conclusion, image optimization is an important factor in website
performance as heavy images contribute to slow load times. To optimize
images, you can use the srcset attribute to provide different versions of an
image for different devices and resolutions, use Tinypng to compress
images without losing quality, and consider using the WebP image format,
which provides better compression than other formats. By implementing
these techniques and tools, you can improve the performance of your
website and provide a faster, better experience for your users.
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PageSpeed Insights

Goals

By the end of this case you will:

- Understand the various metrics used by PageSpeed Insights to evaluate
website performance

- Recognize the importance of optimizing website performance and
accessibility, as well as appreciate the role of best practices and SEO in
improving a website’s visibility and user experience.

- Implement specific recommendations provided by PageSpeed Insights
>

### Introduction

Google

ro.

PageSpeed Insights

PageSpeed Insights (https://pagespeed.web.dev/) is a free tool offered by
Google that also merged with Google’s open-source tool Lighthouse score
check. PageSpeed Insights provides website owners and developers with
information about their website’s performance and suggestions for
improvement.
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What is PageSpeed Insights?

PageSpeed Insights (PSI) evaluates the user experience of a website on both
desktop and mobile devices, offering recommendations for improvement.
The tool provides two types of data, lab and field, to report on the
performance of a page. Lab data is collected in a controlled environment
and is helpful for identifying problems, but may not reflect real-world
performance issues. On the other hand, field data provides a true
representation of the user experience, although it has a more limited range
of metrics.

>

Visit https://pagespeed.web.dev/ and analyze www.apple.com. The results
will look something like the screenshot below.

https://www.apple.com/

O Mobile [ Desktop

Discover what your real users are experiencing This URL  Origin
——a4-  Core Web Vitals Assessment: Failed @
Expand view
Largest Contentful Paint (LCP) ® First Input Delay (FID) Cumulative Layout Shift (CLS),
2.7's 14 ms 0.16
T — ¢ . A
OTHER NOTABLE METRICS
® First Contentful Paint (ECP). @ nteraction to Next Paint (INP) & ® Time to First Byte (TTFB) &

1.55 186‘ms 0.§s

™ Latest 28-day collection period L0 Various mobile devices & Many samples (Chrome UX Report)

& Full visit durations  Various network connections @ All Chrome versions

You can toggle between the Mobile view and the Desktop view.

The real-user experience data in PSI is powered by the Chrome User
Experience Report (CrUX) dataset. It displays information from real users
over the past 28 days, including:

>

Largest Contentful Paint (LCP) - measures the loading time of the largest
element (image, text block, video, etc.) that is visible on a user’s screen. It
provides a user-centric performance metric that represents the loading
experience of a user visiting the website.

>

First Input Delay (FID) - measures the responsiveness of a website. It
measures the time from when a user first interacts with a page (i.e. clicking
a button or typing in a form) to the time when the browser is able to
respond to that interaction. The lower the FID, the better the user



experience.

>

Cumulative Layout Shift (CLS) - measures the stability of a website’s
layout as it is being loaded. The score is used to quantify the amount of
unexpected layout shifts that occur on a website.

>

First Contentful Paint (FCP) - measures the time it takes for the browser
to render the first meaningful element of the page. This can be a text, an
image, or any other content that is visible to the user. The goal is to have
the FCP occur as quickly as possible to provide a better user experience and
reduce the bounce rate.

>

Interaction to Next Paint (INP) - measures the time between when a user
interacts with a page (for example, clicking a link) and the time it takes for
the browser to paint the next frame of the page. In other words, it’s a
measure of how quickly a page responds to user input. The lower the score,
the better it is.

>

Time to First Byte (TTFB) - measure the time it takes for a browser to
receive the first byte of response data from a web server after making an
HTTP request. It represents the time that a user must wait before they start
to receive content.

>

As you scroll down the page, the section below these metrics addresses
performance issues.

O Mobile [ Desktop

Diagnose performance issues

3% 97 100 82

Performance Accessibility Best Practices SEO

\ iPhone 14 Pro
30

Performance ]

Values are estimated and may vary. The performance score is calculated ' .
directly from these metrics. See calculator.
A 0-29 50-89 90-100
iPhone 14
METRICS Expand view
A First Contentful Paint A Time to Interactive
3.1s 19.0s
A Speed Index A Total Blocking Time
11.1s 890 ms
A Largest Contentful Paint Cumulative Layout Shift
17:2:8 0
{5 Captured at Feb 9, 2023, 3:34 PM EST L@ Emulated Moto G4 with Lighthouse 9.6.6 & Single page load
& Initial page load 7 Slow 46 throttling @ Using HeadlessChromium 109.0,5414.101.with Ir

Performance refers to how quickly a webpage loads and displays its
content to the user. PageSpeed Insights evaluates a webpage’s performance



based on various metrics, such as time to first byte, time to display content,
and total load time.

>

Accessibility refers to how well a webpage can be used by users with
disabilities. PageSpeed Insights considers factors such as the availability of
alternative text for images, proper use of heading tags, and the use of
descriptive link text.

>

Best practices refer to the recommended standards and guidelines for
optimizing webpages for performance and accessibility. PageSpeed Insights
provides specific recommendations for improving a webpage’s
performance and accessibility, such as minifying CSS and JavaScript files,
optimizing images, and reducing the number of requests made to the
server.

>

SEO (Search Engine Optimization) refers to the process of improving a
website’s visibility in search engine results pages. PageSpeed Insights
provides recommendations for improving a webpage’s SEO, such as
ensuring that the page has a valid title and description, and that the page’s
content is easily crawlable by search engines.

>

Under each of these, there are breakdowns and suggestions about what to
improve and how to improve it.

>

Some of the recommendations provided by PageSpeed Insights include:

- Minifying CSS and JavaScript files to reduce their size and improve load
time

. Compressing images to reduce their size without sacrificing quality

- Implementing browser caching to reduce the amount of data that needs to
be transferred on subsequent page loads

- Optimizing the order in which resources are loaded to reduce the time it
takes for a page to become interactive

- Reducing the number of HTTP requests required to load a page

>

Scroll further down the analysis results page to read the tool’s
recommendations for improving the performance of www.apple.com.

L vs




PageSpeed Insights provides separate scores for mobile and desktop
versions of a website, reflecting the different performance considerations
for each platform.

>

Mobile scores typically focus on the speed and usability of a page on
smaller screens, with a greater emphasis on optimization for lower-end
devices and cellular networks. Some of the factors that PageSpeed Insights
takes into account when scoring mobile performance include the size of the
page, the time it takes to load, and the use of appropriate coding practices
such as compression and minification.

>

Desktop scores, on the other hand, focus on optimizing the performance of
a page on larger screens and high-speed networks. Factors such as server
response time, the use of caching, and the optimization of images and other
media assets are also taken into consideration.

>

It’s important to note that both mobile and desktop scores are affected by
similar performance optimization techniques. For example, improving the
load time of a page, reducing its size, and optimizing its images and media
assets will generally improve scores for both mobile and desktop versions
of the page.

>

In conclusion, it is crucial to optimize the performance of a website for
both mobile and desktop platforms to ensure the best possible user
experience for all visitors, regardless of their device or network.

>

Overall, PageSpeed Insights is a useful tool for improving the performance,
accessibility, best practices, and SEO of a webpage, which can lead to a
better user experience and increased visibility in search engine results.



Conclusion & Takeaways

Conclusion & Takeaways

PageSpeed Insights is a great tool for evaluating the user experience and
performance of a website on both desktop and mobile devices. The report
that it provides with recommendations for improvement helps you make
adjustments to various metrics such as loading time, responsiveness, layout
stability, and optimization for search engines. When building a website and
working with landing pages it’s important to ensure that they are
optimized and this tool is a great place to start.

>

### Attribution

- About PageSpeed Insights. (n.d.). Google Developers.
https://developers.google.com/speed/docs/insights/v5/about



Analyze a Website

Analyze a Website

Goals

By the end of this project you will:

- Understand how to use PageSpeed Insight tool works

- Use the tool to get insight into possible page improvements

- Decide on 3 page improvements you can make that will optimize your
website

>

### Instructions

Exercise: Analyzing and Improving Website Performance with PageSpeed
Insights

>

Objective: In this activity, you will learn how to use Google’s PageSpeed
Insights tool to analyze a website’s performance and identify areas for
improvement.

>

Generate a PageSpeed Insight report and report the 3 most urgent
Performance recommendations and how to resolve them. You can choose
popular websites or your personal website.

>

1. Visit the PageSpeed Insights tool (https://pagespeed.web.dev/) and enter
the URL of their assigned website.

>

2. Analyze the website’s performance on both mobile and desktop devices.
Take note of the overall scores and the individual metrics like Largest
Contentful Paint (LCP), First Input Delay (FID), Cumulative Layout Shift
(CLS), etc.

>

3. Explore the recommendations provided by the tool for improving the
website’s performance, accessibility, best practices, and SEO.

>

4. After analyzing the recommendations, choose at least three
improvements that you think would have the most significant impact on
your assigned website’s performance.

>

5. Write down your findings, including the overall scores, individual
metrics, and the three chosen improvements.

>

By completing this activity, you will gain hands-on experience using
PageSpeed Insights to analyze and improve website performance. This



knowledge will be valuable for future web development projects and

understanding the importance of website optimization.
>
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